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Lesson 1: Release Introduction 
 

Topic 1: Release Overview 
 
Screen 1: 
 
Course Welcome 
 
 Welcome to the Forms, Declarations, & AD/CVD Cases Web-based 
training (WBT) course!  This 90-minute course is for importers, 
brokers and other authorized trade personnel.  After completing this 
course you will be able to use enhanced functionality of ACE to 
effectively process entry summary type 03 - Anti-Dumping 
Countervailing Duties (AD/CVD) and manage the related case 
information. 
 
The WBT includes five lessons: 
 
Lesson One: Release Overview.  At the end of this lesson, you will be 
able to describe enhancements to the ACE Portal that provide 
functionality for AD/CVD processing. 
 
Lesson Two: AD/CVD Case Management.  At the end of this lesson, 
you will be able to search, display, and print AD/CVD case information. 
 
Lesson Three: AD/CVD Messages.  At the end of this lesson, you will 
be able to search, display, and print AD/CVD messages. 
 
Lesson Four: Declarations.  At the end of this lesson, you will be able 
to maintain declarations for Portal and Non-Portal accounts; in 
addition, brokers will be able to create declarations for Non-Portal 
accounts. 
 
Lesson Five: AD/CVD Reports.  At the end of this lesson, you will be 
able create reports for AD/CVD entry summaries as well as use the 
enhanced reports functionality available in ACE. 
 
Before taking this course, you must be able to log in to ACE. If you do 
not have this prerequisite knowledge, you should complete the Initial 
Login for Trade Account Owners (TAO) WBT before taking this course. 
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Hyperlinks: 
 
Lesson One: Release Overview - http://nemo.cbp.gov/ace_online/AD-
CVD/lesson1.html 
 
 
Lesson Two: AD/CVD Case Management - 
http://nemo.cbp.gov/ace_online/AD-CVD/lesson2.html 
 
 
Lesson Three: AD/CVD Messages - 
http://nemo.cbp.gov/ace_online/AD-CVD/lesson3.html 
 
 
Lesson Four: Declarations - http://nemo.cbp.gov/ace_online/AD-
CVD/lesson4.html 
 
 
Lesson Five: AD/CVD Reports - http://nemo.cbp.gov/ace_online/AD-
CVD/lesson5.html 
 
Screen 2: 
 
Title Screen 

 
 Release Overview 
 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
             
Screen 3: 
 
 Objectives 
 
Upon completion of this topic, Release Overview, you will be able to: 
 
Describe updates to the ACE Portal based on this release, ESAR: 
AD/CVD and Additional Functionality. 
Describe new features and changes with this release. 

http://nemo.cbp.gov/ace_online/AD-CVD/lesson1.html
http://nemo.cbp.gov/ace_online/AD-CVD/lesson1.html
http://nemo.cbp.gov/ace_online/AD-CVD/lesson2.html
http://nemo.cbp.gov/ace_online/AD-CVD/lesson3.html
http://nemo.cbp.gov/ace_online/AD-CVD/lesson4.html
http://nemo.cbp.gov/ace_online/AD-CVD/lesson4.html
http://nemo.cbp.gov/ace_online/AD-CVD/lesson5.html
http://nemo.cbp.gov/ace_online/AD-CVD/lesson5.html
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Describe AD/CVD processing in ACE. 
 
Select the Start button to begin 
 
Image: Computer screen displaying ACE screen. 
 
Screen 4: 
 
ACE Background 
 
The ESAR:AD/CVD and Additional Functionality release of ACE builds 
upon the ESAR: Initial Entry Summary Types release, which was 
deployed in April 2009. 
 
The ESAR: Initial Entry Summary Types release was the first major 
development and delivery of functionality to support entry summary 
processing in ACE. It included transaction processing for entry 
summary types 01 (Consumption Entry) and 11 (Informal Entry) 
received from the trade via Electronic Data Interface (EDI). 
 
Image: Cargo ship pulling into port stacked with containers 
 
Screen 5: 
 
ACE Release Overview 
 
 Move your mouse over the graphics below to review ACE release 
information. 
 
Rollovers are images that change to display additional details or 
information when a mouse cursor is positioned over a specified 
location. The text that appears is called rollover text. 
 
Rollover #1 ESAR: Initial Entry Summary Types 
 
Provides a national database of issued forms, trade responses and CBP 
actions. 
 
Allows importers and their agents to transmit type 01 and type 11 
entry summaries to ACE via Automated Broker Interface (ABI). 
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Allows a preferred mode of communication for CBP forms via ACE. 
 
Allows importers with ACE Portal accounts to view and respond to CBP 
Forms 28, 29, and 4647 issued for ACE entry summaries. 
 
Allows importers with ACE Portal accounts to create and maintain 
blanket declarations in ACE Allows you to override Census warnings 
electronically prior to or after receiving a Census warning message in 
ABI only on ACE entry summaries (eliminates the need for entry 
summaries to be presented as paper). 
 
Allows trade users with ACE Portal accounts to respond through ACE to 
a Post Summary Documents Required message which must contain an 
action number. 
 
Provides new reports. 
 
Rollover #2: ESAR: AD/CVD and Additional Functionality 
 
Allows importers and their agents to transmit type 03 (AD/CVD) entry 
summaries to ACE. 
 
Allows importers with ACE Portal accounts to view and respond to CBP 
Entry Summary Forms 28 (Request for Information) 29, (Notice of 
Action), and 4647 (Notice to Mark/Notice to Re-Deliver) issued for all 
entry summaries (ACS and ACE) 
 
Allows brokers with ACE Portal accounts to create and maintain 
declarations in ACE for Non-Portal accounts. 
 
Provides a national database of issued forms, trade responses, and 
other CBP actions. 
 
Provides two additional and four enhanced reports for brokers and 
importers. 
 
Allows importers and brokers to view AD/CVD information and related 
cases. 
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Images: Rollover#1:  Woman sitting at a desk typing on a 
computer 
Rollover #2:  A bunch of bananas 

 
Screen 6: 
 
Type 03 Entry Summary Processing Changes 
 
The type 03 entry summary processing changes allow either the 
broker or importer to: 
 
Identify different parties at the line level including manufacturer, 
exporter, consignee, and sold to party. 
 
Submit blanket non-reimbursement statements at the line level as part 
of the ABI transmission. 
 
Allow blanket declaration numbers at the line level if the blanket 
declaration record was created in ACE. 
 
Identify ad valorem and specific duty rates by case at the line level.  
 
Note:  ACE only validates the blanket declaration number not the 
actual declaration. 
 
Image: Woman at a computer with a headset on reviewing documents 
 
Screen 7: 
 
Declaration Functionality Updates 
 
 The number of cases that can be associated with a declaration record 
has increased from 1 to 50. 
 
The number of Manufacturer Identification (MID) numbers has 
increased from 20 to 50. 
 
When selecting a declaration to display, a new Case # sub-tab is 
available with a hyperlink for the 10-digit case number. 
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The Search Results section provides a hyperlink for the 10-digit case 
number and displays case information. 
 
These updates will reduce the number of declaration records the 
importer will need to create as well as make it easier to access 
AD/CVD case details. 
 
Image: containers stacked high on rail cars 
 
Screen 8: 
 
Create and Maintain Declarations for Non-Portal Accounts 
 
 The following blanket declarations for Non-Portal accounts are now 
supported in the ACE Portal: 
 
Affidavits of Manufacture 
North American Free Trade Agreement (NAFTA) Certificates of Origin 
Non-Reimbursement Blanket Statements (AD/CVD) 
Importer Certifying Statements 
 
The blanket declaration records created in ACE can be viewed 
nationally by CBP and by trade accounts that have access to blanket 
declarations. 
 
More detailed information is covered in Lesson 4: Declarations. 
 
Hyperlink:  Lesson Four: Declarations - 
http://nemo.cbp.gov/ace_online/AD-CVD/lesson4.html 
 
Image:  Man talking on the phone while holding the mouse and looking 
at the computer screen. 
 
 Screen 9: 
 
Enhancements for CBP Forms 28, 29, and 4547 Responses 
 
 CBP Forms 28, 29, and 4647 are now posted to the Forms sub-tab in 
the Task Selector list in ACE for all entry summaries (ACS and ACE). 
 

http://nemo.cbp.gov/ace_online/AD-CVD/lesson4.html
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The trade can respond to forms electronically, upload the forms to 
their computers, and if needed, attach documents to forms 29, 28, 
and 4647. 
 
Brokers filing ACS summaries are able to run Entry Summary 
Management (EMS) 7025 to view CBP Forms 28, 29, and 4647 that 
have been issued in both ACS and ACE. 
 
Image:  Man writing with a fountain pen on a stack of documents. 
 
Screen 10: 
 
Additional and Enhanced ACE Reports 
 
 Additional ACE Reports for the trade are: 
Aged Liquidated AD/CVD Entry Summary Report (ESM 8027) 
Aged Liquidated AD/CVD Entry Summary Extract Report (AD 8027) 
 
The following enhancements for AD/CVD Information: 
  Entry Summary (ESM 7068) 
  Entry Summary Line Detail (ESM 7008) 
  CBP Form 28, 29, 4647 Status (ESM 7025) 
 
The Trade Declaration Report has been modified to capture the 
declaration information that brokers enter for Non-Portal accounts. 
 
See Lesson 5: AD/CVD Reports for more details on additional and 
enhanced ACE Reports. 
 
Hyperlink: Lesson Five: AD/CVD Reports - 
http://nemo.cbp.gov/ace_online/AD-CVD/lesson5.html 
 
Image:  A stock market report showing a graph 
 
Screen 11: 
 
AD/CVD Overview 
 
 In addition to enhancements to current functionality within ACE, the 
release also includes the ability to process type 03 (AD/CVD) entry 
summaries. 

http://nemo.cbp.gov/ace_online/AD-CVD/lesson5.html
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Anti-Dumping duties are assessed when a foreign firm sells 
merchandise in the U.S. market at a price lower than the price it 
charges for a comparable product sold in its home market. 
 
The practice of dumping may result in material injury to U.S. 
industries. 
 
Countervailing duties are assessed when grants or subsidies are paid 
by a foreign country to a manufacturer, producer, or exporter of 
merchandise to the United States from that foreign country.  
 
Image:  A machine used to pick containers off of a ship placed next to 
the dock. 
 
Screen 12: 
 
AD/CVD Cases Processing Procedure 
 
 An AD/CVD Case is an electronic reference file used by the entry 
summary transaction system as well as ACE Portal users to validate 
information. 
 
Move your mouse over the graphics below to review ACE release 
information. 
 
Rollover #1: 
Step 1: 
Creation of 
AD/CVD Case 
The filer prepares and designates the entry summary accordingly by 
using the appropriate entry type code, such as 03. 
 
Rollover #2: 
Step 2:  
Filing AD/CVD  
Entry Summary 
If the validations pass, the entry summary is accepted and stored in 
ACE. 
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Rollover #3: 
Step 3: 
Validation 
 
Image: Steps leading up a flight of stairs 
 
   
Screen 13: 
 
AD/CVD Cases in ACE 
 
 An AD/CVD Case in ACE is: 
 
Used for entry summary processing to validate inbound entry 
summary transactions sent via EDI. 
 
Created upon initiation of an AD/CVD investigation and is based on the 
country, product, and company under investigation. 
  
Maintained electronically in the ACE Portal to reflect case-specific 
information such as case number, country, product, case status, and 
company specific information including milestone dates and cash 
deposit rates. The trade community will be able to search, display, and 
print case information and case messages. 
 
Image:  3 CBP Officers inspecting cargo. 
 
Screen 14: 
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
From the list below, choose the best answer to complete the sentence 
and then select the Check Answer button. 
 
ACE release, ESAR: AD/CVD and Additional Functionality: 
 
A) Allows 1,2,3, and 11 type entry summaries to be transmitted to 
ACE. 
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B) Allows brokers to create and maintain specific blanket declarations 
in ACE for Non-Portal accounts 
C) Provides a local database of issued forms and trade responses 
 
D) All of the above 
 
The correct answer is B.  
 
Image:  Pencil filling in an answer on a standardized test. 
 
 Check Answer 
 
Screen 15: 
 
Knowledge Check Question 2 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
An AD/CVD case in ACE will be: 
 
A) Used to edit entry summary transactions sent via EDI 
 
B) Based on the country, product, and the company under 
investigation 
 
C) Maintained electronically to reflect case-specific information 
 
D) All of the above 
 
 The correct answer is D.  

 
Image:  Pencil filling in an answer on a standardized test. 
 
Screen 16: 
 
Summary 
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 Summary 
 
Congratulations!  You have completed Topic 1: Release Overview.  You 
now have the knowledge necessary to: 
 
Describe updates to the ACE Portal Based on release, ESAR: AD/CVD 
and Additional Functionality. 
 
Describe new features and changes with this release. 
 
Describe AD/CVD processing in ACE. 
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Lesson 2: AD/CVD Case Management 
 

Topic 1: Search and Display AD/CVD Case Information 
 
Screen 1:   
 
Title Screen 

 
 AD/CVD Case Management - Search and Display Case Information 
 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
 Screen 2:   
 
 Objectives 
 
Upon completion of this topic, Search and Display AD/CVD Case 
Information, you will be able to: 
 
Use search criteria to locate and display an AD/CVD Case in ACE. 
 
Select the Start button to begin 
 
Image: Computer screen displaying ACE screen. 
 
Screen 3:   
 
AD/CVD Case Management 
 
 An AD/CVD case is an electronic reference file used by the entry 
summary system as well as Portal users to validate information.   
 
The case information is maintained electronically in ACE to reflect case 
and company specific information, including milestone dates and cash 
deposit rates. 
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Image: 3 CBP Officers inspecting cargo. 
            
Screen 4:  
 
Using ACE for an AD/CVD Case Search 
 
 You will have the ability to search for AD/CVD cases in ACE using 
various search filters.   
 
There are numerous filters available to aid in the search process and 
some  filters without a drop-down menu allow for the use of the 
wildcard character (*).  
 
The filters are not case-sensitive and the use of upper or lower case 
characters is acceptable. 
 
Note:  In reports, the % sign will still be the wildcard symbol but in the 
ACE Portal, the * symbol is the standard wildcard symbol. 
 
Image: 2 CBP Officers removing cargo from a pallet. 
 
Screen 5:  
 
Search Overview 
 
 To access the search functionality for an AD/CVD Case in the ACE 
Portal: 
 
From the Home page of the ACE Portal, select the References tab. 
 
Image: Home page of the ACE Portal containing four tabs at the top of 
the screen; Home, Accounts, References, and Tools. The third tab from 
the left is the References tab. 
 
Click box: Select the References tab to continue. 
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Screen 6:  
 
Search Overview 
 
 Select AD/CVD Cases Search in the Task Selector portlet to navigate 
to the Search AD/CVD Cases portlet. 
 
Image: References page in the ACE Portal. This page is divided into 
two portlets. The Task Selector portlet is on the left side of the screen. 
The task selected from the Task Selector portlet displays in a portlet 
on the right side of the screen. Tasks are listed as hyperlinks in the 
Task Selector portlet. The tasks displayed are: HTS, Tariff History, 
Port, Gold Rate, Currency Exchange, Country Code, MID, UN Loc Code, 
AD/CVD Cases Search, and AD/CVD Messages Search. 
 
Click box: Select AD/CVD Cases Search to continue. 
 
Screen 7:  
 
Search Overview 
 
 Not applicable. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page.  
 
Screen 8:  
 
Search Overview 
 
 Rollover each filter to display information on how to use in a search. 

 
Rollover #1: Case # 
Case # - Search on a complete case number or a wildcard search with 
an abbreviated case number with a minimum of four characters and an 
asterisk.  Dashes do not need to be included. (for example, A123*). 
 
Rollover #2: Country 
Country - Select the ISO country code and country name from the 
drop-down list. 
 
Rollover #3: HTS # 



Web-based Training Guide for   Lesson 2 
Forms, Declarations, & AD/CVD Cases Web-based Training  
 

17 

HTS # - Search with a minimum of four characters with no dashes, 
periods, or spaces. The wildcard asterisk must be used if 8 to 10 
characters are not provided for the search. 
 
Rollover #4: Party Name 
Party Name - Search with a minimum of four characters with no 
wildcard required. 
 
Rollover #5: Party ID 
Party ID - Search with an asterisk and a minimum of four characters if 
the full name is not available. 
Rollover #6: Company Status 
Company Status - Select a company status (active or inactive) from 
the drop-down list.  
 
Rollover #7: Short Description 
Short Description - Type a description up to 30 characters or perform a  
search with a minimum of four characters and no wildcard.  Any 
keyword matching the short description returns search results. 
 
Image: Zoomed in image of the Search AD/CVD Cases portlet.  
 
Screen 9:  
 
AD/CVD Case Search Options 
 
 ACE now provides the functionality to search for an AD/CVD case 
using three search criteria options as follows: 
 
1. Complete case number to retrieve case information.  
2. Partial case number with the wildcard (*) and one other search 
filter. 
3. Two search filters.  
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. 
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Screen 10:  
 
Search Option One 
 
 If the complete case number is known, select the Case # text box and 
type A570901001 and then select the Space Bar to continue. 
 
Note: If the complete case number is input, there is no need for 
additional search criteria. 
 
Highlight box: The text field for the Case # filter is highlighted. 
 
Text box: The user is able to type the appropriate Case # 
(A570901001) in the Case # text field. If the user types this number 
incorrectly, he or she receives the message, Please try again.   
Reminder: Type A570901001 in the Case # text box. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. 
 
 
Screen 11:  
 
Search Option One 
 
 Select Search to see your results. 
 
Highlight box: The Search button is highlighted. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. Beneath the filters are two buttons, Search and 
Clear. 
 
Click box: Select the Search button to continue. 
 
Screen 12:  
 
Search Option One Case Results 
 
 Shown here are the results of the search.  
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Notice ACE automatically includes the dashes in the Case #. 
The case information is displayed in two distinct sections and 
associated Sub-tabs: 
 
Company Header  
Department of Commerce - Import Administration (DOC-IA) Contact 
Sub-tabs: Rates, Events, B/C, AR, Parties, HTS #, and Susp ES 
 
Image: The View AD/CVD Company portlet displays on the right side 
of the References page as a result of selecting the Search button in the 
Search AD/CVD Cases portlet. As described above, this portlet is 
divided into two sections (Company Header and Department of 
Commerce) and associated Sub-tabs. 
 
Screen 13:  
 
Search Option One Case Results 
 
 To clear the results of the first search: 
Select the AD/CVD Cases Search, located on the Task Selector to 
return to the Search AD/CVD Cases portlet. 
 
Highlight box: The AD/CVD Cases Search task is highlighted. 
 
Image: The View AD/CVD Company portlet displays on the right side 
of the References page. The Task Selector portlet displays on the left 
side of the References page. 
 
Click box: Select the AD/CVD Cases Search task to continue. 
 
Screen 14:  
 
Search Option One Clear Results 
 
 Notice the case number is still visible in the Case # text entry field. 
 
Select the Clear button to clear your previous search. 
 
Highlight box #1: The text field for the Case # filter is highlighted. 
 
Highlight box #2: The Clear button is highlighted. 
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Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. The Case # entered previously remains on the 
screen. 
 
Click box: Select the Clear button to continue. 
 
 
Screen 15:  
 
Search Option Two 
 
 Now we will use a combination of filters to search for a case.  This 
option is used in instances where the full case number is not available 
for searching for an AD/CVD case. 
 
Remember, ACE allows for the use of a wildcard (asterisk) in search 
criteria with a minimum of four characters for a case number; for 
example, A570*.  
  
In this example, the Company Status drop-down option and the Case 
# box will be used as the search filters and the Search Button will be 
selected to view the results. 
 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The Search AD/CVD Cases portlet displays on the 
right side of the References page.  
 
Screen 16:  
 
Search Option Two 
 
 Select the Company Status drop-down list arrow. 
 
Highlight box: The Company Status drop-down list arrow is 
highlighted. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. The Company Status drop-down list arrow is on 
the far right side of the Search AD/CVD Cases portlet. 
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Click box: Select the Company Status drop-down list arrow to 
continue. 
 
Screen 17:  
 
Search Option Two 
 
 Select Active from the drop-down list. 
 
Highlight box: The Active option is highlighted. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. The Company Status drop-down list is on the far 
right side of the Search AD/CVD Cases portlet. The user is able to 
select from the drop-down list options displayed, which include Active, 
Inactive – Final exclusion, Inactive – Termination, Inactive – Company 
Revoked, Inactive – Order Revoked, Inactive – Company Deactivated, 
and Inactive – Deactivated. 
 
Click box: Select Active to continue. 
 
Screen 18:  
 
Search Option Two 
 
 Select the Case # text box, type A570* and then select the Space Bar 
to continue. 
 
Highlight box: The text field for the Case # filter is highlighted. 
 
Text box: The user is able to type the appropriate partial Case # with 
the asterisk wildcard symbol (A570*) in the Case # text field. If the 
user types this value incorrectly, he or she receives the message, 
Please try again.   
Reminder: Type A570* in the Case # text box. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. 
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Screen 19:  
 
Search Option Two 
 
 Select Search. 
 
Highlight box: The Search button is highlighted. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. Beneath the filters are two buttons, Search and 
Clear. 
 
Click box: Select the Search button to continue. 
 
Screen 20:  
 
Search Option Two Results 
 
 ACE displays the search results based on the search criteria of a 
partial Case # and Company Status.   
 
In the example shown here, ACE displays a listing of possible matches 
in Search Results. 
 
Page number hyperlinks at the bottom of Search Results allow you to 
view additional cases, based on the search criteria. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. At the bottom of the portlet, Search Results 
display. Page number hyperlinks display below the Search Results. 
 
Screen 21:  
 
Search Option Two  
 
 To begin Search Option Three, select the Clear button. 
 
Highlight box: The Clear button is highlighted. 
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Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. At the bottom of the portlet, Search Results 
display. Above the Search Results are two buttons, Search and Clear. 
 
Click box: Select the Clear button to continue. 
 
 
Screen 22:  
 
Search Option Three  
 
 When the complete or partial case number is not available, there are 
multiple filters that may be applied in performing a search for an 
AD/CVD case.   
 
A minimum of two filters must be used for a search unless the entire 
case number is known and input by the user. 
 
In this example, the Party Name and Short Description filters will be 
used and each filter only requires a minimum of four characters and no 
wildcard. 
 
Note:  Remember, a wildcard is not required in the Party Name and 
Short Description, text boxes.  If the wildcard is used in those text 
boxes, ACE will return  a “No Data Found” message. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. 
 
Screen 23:  
 
Search Option Three  
 
 Type Nanj in the Party Name text box, and then select the Space Bar 
to continue. 
 
Highlight box: The text field for the Party Name filter is highlighted. 
 
Text box: The user is able to type the appropriate Party Name (Nanj) 
in the Party Name text field. If the user types this name incorrectly, he 
or she receives the message, Please try again.   
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Reminder: Type Nanj in the Party Name text box. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. 
 

Screen 24:  
 
Search Option Three  
 
 Select the Short Description text box and type Small to find all 
instances of cases with a short description of Small Diameter and then 
select the Space Bar to continue. 
 
Highlight box: The text field for the Short Description filter is 
highlighted. 
 
Text box: The user is able to type the appropriate Short Description 
(Small) in the Short Description text field. If the user types this text 
incorrectly, he or she receives the message, Please try again.   
Reminder: Type Small in the Short Description text box. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. 
 
Screen 25:  
 
Search Option Three  
 
 Select Search to see your results. 
 

Highlight box: The Search button is highlighted. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. Beneath the filters are two buttons, Search and 
Clear. 
 
Click box: Select the Search button to continue. 
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Screen 26:  
 
Search Option Three Results 
 
 ACE displays the search results based on the search criteria of Party 
Name and Short Description with a listing of possible matches in 
Search Results. 
 
Selecting any of the Case # hyperlinks displays the company details 
for that case. 
 
If the search fails to display the intended results, select the Clear 
button and redefine your search criteria. 
 
Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. At the bottom of the portlet, Search Results 
display.  
 
Screen 27:  
 
Search Summary 
 
 Use different search criteria to search for and display an AD/CVD Case 
in ACE which include: 
 
The complete 10 digit case number is the only filter you need in order 
to display a case. 
 
Partial case numbers with a minimum of four characters and the 
wildcard requires one other filter. 
 
A minimum of two filters which are required to perform a search if you 
do not know the 10 digit case number. 
 
Party Name and Short Description filters only require a minimum of 4 
characters with no wildcard.  Using a wildcard for these filters will 
result in a ‘No Data Found’ message. 
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Image: The Search AD/CVD Cases portlet displays on the right side of 
the References page. At the bottom of the portlet, Search Results 
display.  
 
Screen 28:  
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
What is the minimum number of characters needed to complete a 
wildcard search? 
 
A) 4 
B) 3 
C) 6 
D) 2 
 
The correct answer is A.  
 
Image:  Pencil filling in an answer on a standardized test. 
 
   
Screen 29:  
 
Knowledge Check Question 2 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
Which search criteria allows the use of the * wildcard? 
 
A) Short Description 
B) Party Name 
C) Case Number 
D) All of the Above 
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The correct answer is D.  
 
Image:  Pencil filling in an answer on a standardized test. 
 
Screen 30:  
 
Summary 
 
 Summary 
 
Congratulations!  You have completed Topic 1: Search and Display 
AD/CVD Case Information.  You now have the knowledge necessary 
to: 
 
Use search criteria to locate and display an AD/CVD Case in ACE. 
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Topic 2: Display AD/CVD Case Information 
 
Screen 1:   
 
Title Screen 

 
 AD/CVD Case Management - Display AD/CVD Case Information 
 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
Screen 2:   
 
 Objectives 
 
Upon completion of this topic, Display AD/CVD Case Information, you 
will be able to: 
 
Display AD/CVD case and company information in ACE. 
 
Select the Start button to begin 
 
Image: Computer screen displaying ACE screen. 
 
 Screen 3:  
 
Display AD/CVD Case Information Overview 
 

 Topic one of this lesson introduced the different options you have to 
search for a case within the ACE Portal.  This topic will identify what 
ACE will display once a search has been completed. 
 
The View AD/CVD Company portlet is divided into two sections as well 
as additional Sub-tabs:  
 
Company Header  
Department of Commerce - Import Administration (DOC-IA) Contact 
Sub-tabs: Rates, Events, B/C, AR, Parties, HTS #, and Susp ES  
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Image: The View AD/CVD Company portlet displays on the right side 
of the References page as a result of selecting the Search button in the 
Search AD/CVD Cases portlet. As described above, this portlet is 
divided into two sections (Company Header and Department of 
Commerce) and associated Sub-tabs. 
 
Screen 4:  
 
Company Header Section 
 

 The Company Header contains information related to a specific case 
and displays three hyperlinks that provide additional information on 
the Country, View Official Case Name and if there were any related 
cases, Related Case #.   
 
Image: Zoomed in image of the Company Header section of the View 
AD/CVD Company portlet.  
               
Screen 5:  
 
Company Header Section 
 

 The Company Header contains information related to a specific case 
and displays three hyperlinks that provide additional information on 
the Country, View Official Case Name and if there were any related 
cases, Related Case #.   
 
Select the Country hyperlink in the Company Header section. 
 
Highlight box: The Country hyperlink is highlighted. 
 
Image: Zoomed in image of the Company Header section of the View 
AD/CVD Company portlet. 
 
Click box: Select the Country hyperlink to continue. 
 
Screen 6:  
 
Company Header Section - Country 
 

 Selecting the Country hyperlink in the Company Header section 
displays specific information for the selected country.  If you would like 
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to view other country information, simply go to the Country drop-down 
menu, choose the country and select Search. 
 
Note: While in the ACE Portal, do not use the browser navigation 
located at the top of the browser to return to the previous screen. 
 
To return to the View AD/CVD Company section, select the AD/CVD 
Cases Search hyperlink located in the Task Selector portlet. 
 
Highlight box: The AD/CVD Cases Search hyperlink in the Task 
Selector portlet is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The Country Code portlet displays on the right side 
of the References page.  
 
Click box: Select the AD/CVD Cases Search hyperlink to continue. 
 
Screen 7:  
 
Company Header Section – View Official Case Name 
 
 Select the Company Details hyperlink located in the Task Selector 
portlet. 
 
Highlight box: The Company Details hyperlink in the Task Selector 
portlet is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The Search AD/CVD Cases portlet displays on the 
right side of the References page.  
 
Click box: Select the Company Details hyperlink to continue. 
 
Screen 8:  
 
Company Header Section – View Official Case Name 
 
 Select the View Official Case Name hyperlink located in the Company 
Header section of the View AD/CVD Company portlet. 
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Highlight box: The View Official Case Name hyperlink in the Company 
Header section of the View AD/CVD Company portlet is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page. The View AD/CVD Company portlet 
is divided into two distinct sections (Company Header and DOC-IA 
Contact) and associated Sub-tabs. 
 
Click box: Select the View Official Case Name hyperlink to continue. 
 
Screen 9:  
 
Company Header Section – View Official Case Name 
 
 Selecting the View Official Case Name hyperlink displays: 
 
Case # 
Short Description  
Detailed Description of the Official Case  
 
To return to the Company Header section, select the Back button 
located within the Official Case Name section of the View AD/CVD 
Company Case portlet. 
 
Highlight box: The Back button is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company Case portlet displays on 
the right side of the References page. At the bottom of this portlet is a 
Back button. 
 
Click box: Select the Back button to continue. 
 
 
Screen 10:  
 
DOC - IA Contact Section 
 
 The DOC - IA Contact section displays information associated with the 
Import Administration office along with a point of contact and phone 
numbers for inquiries or requests for information.    
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Image: Zoomed in image of the DOC - IA Contact section of the View 
AD/CVD Company portlet.  
 
Screen 11:  
 
Company Information Overview / Rates Sub-Tab 
 
 Sub-tabs display additional information for the case.  
 
Currently the Rates sub-tab is displayed.  The Rates sub-tab displays 
information on the deposit rates used to calculate estimated anti-
dumping and countervailing duties for the case. 
 
Please select each tab to view additional information.  Once finished, 
select the Task Selector Portlet on the left to continue. 
 
Please select the hyperlinked sub-tabs for additional information.  
 
After reviewing all the sub-tabs select the Task Selector to continue. 
 
Highlight box #1: The View AD/CVD Company sub-tabs are 
highlighted. 
 
Highlight box #2: The Task Selector portlet is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page. At the bottom of the portlet are 
seven sub-tabs; Rates, Events, B/C, AR, Parties, HTS#, and Suspend 
Entry Summary. 
 
Click box: Select the hyperlinked sub-tabs to continue. 
 
Screen 12:  
 
Events Sub-Tab 
 
The Events sub-tab displays a chronological list of all events that occur 
throughout the lifecycle of the AD/CVD case, including any 
determinations associated with the events.  
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The determinations are based on the results of the investigation by the 
International Trade Commission and the Department of Commerce. 
 
Please select the hyperlinked sub-tabs for additional information.  
 
After reviewing all the sub-tabs select the Task Selector to continue. 
 
Highlight box #1: The View AD/CVD Company sub-tabs are 
highlighted. 
 
Highlight box #2: The Task Selector portlet is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page. At the bottom of the portlet are 
seven sub-tabs; Rates, Events, B/C, AR, Parties, HTS#, and Suspend 
Entry Summary. 
 
Click box: Select the hyperlinked sub-tabs to continue. 
 
Screen 13:  
 
B/C (Bonds/Cash) Sub-Tab 
 
 The B/C (Bonds/Cash) sub-tab displays information on any bonds or 
cash associated with the case. 
 
Please select the hyperlinked sub-tabs for additional information.  
 
After reviewing all the sub-tabs select the Task Selector to continue. 
 
Highlight box #1: The View AD/CVD Company sub-tabs are 
highlighted. 
 
Highlight box #2: The Task Selector portlet is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page. At the bottom of the portlet are 
seven sub-tabs; Rates, Events, B/C, AR, Parties, HTS#, and Suspend 
Entry Summary. 
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Click box: Select the hyperlinked sub-tabs to continue. 
 
Screen 14:  
 
AR (Administrative Review) Sub-Tab 
 
 The AR (Administrative Review) sub-tab displays period of review 
information for the case and provides a hyperlink under Msg #: to 
view the company liquidation message(s). 
 
 Please select the hyperlinked sub-tabs for additional information.  
 
After reviewing all the sub-tabs select the Task Selector to continue. 
 
Highlight box #1: The View AD/CVD Company sub-tabs are 
highlighted. 
 
Highlight box #2: The Task Selector portlet is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page. At the bottom of the portlet are 
seven sub-tabs; Rates, Events, B/C, AR, Parties, HTS#, and Suspend 
Entry Summary. 
 
Click box: Select the hyperlinked sub-tabs to continue. 
 
Screen 15:  
 
Parties Sub-Tab 
 
 The Parties sub-tab displays Manufacturer and Exporter detail 
information. 
 
Please select the hyperlinked sub-tabs for additional information.  
 
After reviewing all the sub-tabs select the Task Selector to continue. 
 
Highlight box #1: The View AD/CVD Company sub-tabs are 
highlighted. 
 
Highlight box #2: The Task Selector portlet is highlighted. 
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Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page. At the bottom of the portlet are 
seven sub-tabs; Rates, Events, B/C, AR, Parties, HTS#, and Suspend 
Entry Summary. 
 
Click box: Select the hyperlinked sub-tabs to continue. 
               
Screen 16:  
 
HTS # (Harmonized Tariff Schedule Number) Sub-Tab 
 
 The Harmonized Tariff Schedule Number (HTS #) displays the HTS 
number of the merchandise associated with the AD/CVD case. 
 
Please select the hyperlinked sub-tabs for additional information.  
 
After reviewing all the sub-tabs select the Task Selector to continue. 
 
Highlight box #1: The View AD/CVD Company sub-tabs are 
highlighted. 
 
Highlight box #2: The Task Selector portlet is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page. At the bottom of the portlet are 
seven sub-tabs; Rates, Events, B/C, AR, Parties, HTS#, and Suspend 
Entry Summary. 
 
Click box: Select the hyperlinked sub-tabs to continue. 
 
Screen 17:  
 
Suspend Entry Summary (Susp ES) Sub-Tab 
 
 The Suspended Entry Summary (Susp ES) sub-tab displays a 
chronological log of entry summary suspensions.  
 
Please select the hyperlinked sub-tabs for additional information.  
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After reviewing all the sub-tabs select the Task Selector to continue. 
 
Highlight box #1: The View AD/CVD Company sub-tabs are 
highlighted. 
 
Highlight box #2: The Task Selector portlet is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page. At the bottom of the portlet are 
seven sub-tabs; Rates, Events, B/C, AR, Parties, HTS#, and Suspend 
Entry Summary. 
 
Click box: Select the hyperlinked sub-tabs to continue. 
 
 
Screen 18:  
 
Task Selector Navigation - Company Details 
 
 The Task Selector portlet contains the Company Details hyperlink 
which allows you to return to the last, previously displayed case 
search. 
  
If you navigate away from a search results screen and then want to 
return to the case, simply select the Company Details hyperlink and 
ACE displays the results of the last case search. 
 
Highlight box: The Company Details hyperlink is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page.  
 
Click box: Select the Company Details hyperlink to continue. 
 
Screen 19:  
 
Task Selector Navigation - Company Details 
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 Once a case displays, the trade also has the option to select the 
Messages hyperlink, located in the Task Selector portlet to view any 
messages associated with the displayed case. 
 
Select the Messages hyperlink to continue.  
 
Highlight box: The Messages hyperlink is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page.  
 
Click box: Select the Messages hyperlink to continue. 
 
Screen 20:  
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
What is the easiest way to display a case from a previous search? 
 
A) AD/CVD Search hyperlink 
 
B) Clear button 
 
C) Company Details hyperlink 
 
D) References tab 
 
The correct answer is C.  
 
Image:  Pencil filling in an answer on a standardized test. 
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Screen 21:  
 
 Summary 
 
Congratulations!  You have completed Topic 2: Display AD/CVD Case 
Information.  In this topic, you have learned to: 
 
Display AD/CVD case and company information in ACE. 
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Topic 3: Print AD/CVD Case Information 
 
Screen 1:   
 
Title Screen 

 
 AD/CVD Case Management - Print AD/CVD Case Information 

 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
  
Screen 2:   
 
 Objectives 
 
Upon completion of this topic, Print AD/CVD Case Information, you will 
be able to: 
 
Print AD/CVD information. 
 
Save a file of AD/CVD Case information. 
 
Select the Start button to begin 
 
Image: Computer screen displaying ACE screen. 
 
Screen 3:   
 
Overview 
 
 There may be instances when Company Header and Company Case 
information needs to be printed for review or future reference.  
  
Topics 1 and 2 of this lesson demonstrated how to search and display 
so now we will demonstrate how to print company case information in 
ACE. 
 
You may also save the file to the local drive. 
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Image: Cargo ship docked at port. 
 
Screen 4:   
 
Print Preview 
 
 ACE will display the Company and DOC-IA Contact header information 
along with the default sub-tab information on Rates.  To display the 
Company and DOC-IA Header information with any of the other sub-
tabs, select the sub-tab and information relating to that sub-tab will 
display. 
 
Select the Events sub-tab.  The Company Header and Events sub-tab 
will now display. 
 
Highlight box: The Events sub-tab is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
right side of the References page. At the bottom of the portlet are 
seven sub-tabs; Rates, Events, B/C, AR, Parties, HTS#, and Suspend 
Entry Summary. 
 
Click box: Select the Events sub-tab to continue. 
 
Screen 5:   
 
Print Preview 
 
 ACE gives users the ability to print search results. 
 
To view and print the Events for this Case: 
 
Select the Print View hyperlink.  A pop-up window will display once you 
select Print View.   
 
Highlight box: The Print View hyperlink is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The View AD/CVD Company portlet displays on the 
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right side of the References page. At the bottom of the portlet, the 
Events sub-tab is selected. The Print View hyperlink is at the far right 
side of the Events sub-tab. 
 
Click box: Select the Print View hyperlink to continue. 
 
Screen 6:   
 
Print Preview 
 
 To print your case information select File from the pop-up window. 
 
Highlight box: The File menu is highlighted. 
 
Image: The Print View pop-up window displays. 
 
Click box: Select the File menu to continue. 
 
Screen 7:   
 
Preview AD/CVD Case Information 
 
 In order to view the Header information before printing, select Print 
Preview. 
 
Note: You also have the option to select Save As from the menu to 
save the file to your local computer. 
 
Highlight box: The Print Preview… option is highlighted. 
 
Image: The Print View pop-up window displays with the File menu 
expanded. 
 
Click box: Select the Print Preview… option to continue. 
 
Screen 8:   
 
Preview AD/CVD Case Information 
 
 Once you have previewed the information, select the Printer icon 
button.   
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Highlight box: The Printer icon is highlighted. 
 
Image: The Print Preview window displays. The Printer icon is located 
in the top left corner of the window. 
 
Click box: Select the Printer icon to continue. 
 
Screen 9:   
 
Preview AD/CVD Case Information 
 
 Select the Print button.  Your document will print to your local printer. 
 
Highlight box: The Print button is highlighted. 
 
Image: The Print pop-up window displays.  
 
Click box: Select the Print button to continue. 
 
Screen 10:   
 
Print Preview  
 
 To save your case information select File from the pop-up window. 
 
Highlight box: The File menu is highlighted. 
 
Image: The Print View pop-up window displays. 
 
Click box: Select the File menu to continue. 
 
Screen 11:   
 
Save AD/CVD Case Information to a File  
 
 You have the option to select Save As from the menu to save the file 
to your local computer. 
 
Once you select the Save As option, a pop-window will appear.  Make 
sure you change the file type to Text by selecting Text File from the 
Save as type drop-down menu. 
 
Select Save As... from the File drop down menu. 
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Highlight box: The Save As... option is highlighted. 
 
Image: The Print View pop-up window displays with the File menu 
expanded. 
 
Click box: Select the Save As... option to continue. 
 
Screen 12:   
 
Print Preview  
 
 After naming your file select the Save button.  
 
Highlight box: The Save button is highlighted. 
 
Image: The Save a Copy… pop-up window displays. The Save button is 
in the lower right corner of the pop-up window. 
 
Click box: Select the Save button to continue. 
 
Screen 13: 
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
Which default sub-tab information will print along with the header 
information? 
 
A) Events 
 
B) Rates 
 
C) HTS# 
 
D) None of the above 
 
 The correct answer is B.  
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Image:  Pencil filling in an answer on a standardized test. 
 
 Screen 14: 
 
Summary 
 
 Summary 
 
Congratulations!  You have completed Topic 3: Print AD/CVD Case 
Information.  In this topic, you have learned to: 
 
Print AD/CVD information. 
 
Save a file of AD/CVD Case information. 
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Lesson 3: AD/CVD Messages 
 

Topic 1: Search AD/CVD Messages 
 
Screen 1: 
 
Title Screen 

 
 AD/CVD Messages - Search AD/CVD Messages 

 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
                 
Screen 2: 
 
Objectives 
 
 Objectives 
 
 

Upon completion of this topic, Search AD/CVD Messages, you will be 
able to: 
 
Use various search filters to locate an AD/CVD message in ACE. 
 

Image: Computer screen displaying ACE screen. 
 
Screen 3: 
 
AC/CVD Case Management 
 
 AD/CVD Messages Overview 
 
An AD/CVD message is an electronic message created by Department 
of Commerce / Import Administration (DOC/IA) to instruct CBP to take 
a specific action based on a milestone case decision. 
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Currently, you access messages via the CBP.gov website in order to 
retrieve, view, and print public messages concerning AD/CVD cases. 
 
Messages stored within ACE can provide more detailed information 
than is currently available from the CBP.gov website. 
 
With this release, ACE provides companies with ACE accounts the 
ability to access more detailed AD/CVD messages.  ACE becomes the 
system of record for all AD/CVD messages. 
 
Image: CBP Officer reviewing contents of a box 
 
  
Screen 4: 
 
Using ACE for an AD/CVD Case Search 
 
 AD/CVD Message Search Options 
 
ACE provides the functionality to search for AD/CVD messages using 
three search options: 
 
Type a complete message number, or 
 
Type a partial message or case number along with the wildcard (*) 
and one other search filter to receive a listing of messages, or 
 
Type the message date (both to and from) and an additional filter.   
 
Image: 3 CBP officers reviewing the contents of a fruit box 
 
  
Screen 5: 
 
Search Overview 
 
 Access AD/CVD Messages Search. 
 
Image: References page in the ACE Portal. This page is divided into 
two portlets. The Task Selector portlet is on the left side of the screen. 
The task selected from the Task Selector portlet displays in a portlet 
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on the right side of the screen. Tasks are listed as hyperlinks in the 
Task Selector portlet. The tasks displayed are: HTS, Tariff History, 
Port, Gold Rate, Currency Exchange, Country Code, MID, UN Loc Code, 
AD/CVD Cases Search, and AD/CVD Messages Search. 
 
Click box: To access the Search AD/CVD Message functionality in ACE, 
select AD/CVD Messages Search from the Task Selector portlet. 
 
Screens  6 & 7: 
 
Search Criteria 
 
 Use AD/CVD Search Criteria 
 
Rollover each filter to display information on how to use in a search. 

 
Rollover #1: Message # 
Message # - Type the complete message number.  Another option is 
to perform a wildcard search consisting of a minimum of four 
characters and an asterisk.  Dashes do not need to be included.  e.g., 
9235* 
 
Rollover #2: Message Type 
Message Type - Select the message type pertaining to the AD/CVD 
case from the drop-down list. 
 
Rollover #3: Message Sub-Type 
Message Subtype - Select the message sub-type associated with the 
message type from the drop-down list.  
 
Rollover #4: Message Status 
Message Status.  Select either active or inactive from the drop-down 
list. 
 
Rollover #5: Message Date (from) 
Message Date (from) - Select the start date of the search by either 
typing in the start date (mm/dd/yyyy) or accessing the ACE calendar. 

 
Rollover #6: Message Date (to) 
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Message Date (to) - Select the end date of the search by either typing 
in the end date (mm/dd/yyyy) or select the ACE calendar by selecting 
the calendar icon. 
 
Rollover #7: Case # 
Case # - Type the complete case number or perform a wild card 
search with an abbreviated case number, a minimum of four 
characters, and an asterisk.  Dashes do not need to be included.  For 
example, A463*. 
 
Rollover #8: Court # 
Court # - Type the court order number for the AD/CVD case. 
 
Rollover #9: Party ID 
Party ID - Type the Party ID associated with the AD/CVD case.  There 
are a number of trade accounts associated with an entry summary and 
the Party ID is the unique identifier for that account. 
 
Rollover #10:  Message Title 
Message Title - Type a description up to 30 characters or perform a 
wildcard search with a minimum of four characters.  Any keyword 
matching the message title will return search results 
 
Rollover #11: Reference message # 
Reference Message # - Type a reference message number. 
 
Rollover #12: POR Search Date 
POR Search Date - Select a date that falls within the Period of Review 
(POR). 
 
Rollover #13: Effective Date 
Effective Date - Select a date the message was put into effect by CBP. 
Choose either the ACE calendar or type in the date using the 
(mm/dd/yyyy) format. 
 
Image: Zoomed in image of the Search AD/CVD Messages portlet.  
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Screen 8 
 
Search Option One 
 
 Select the Message # text box and type 9293202, and then select the 
Space Bar to continue. 
 
If the complete case number is known, there is no need for additional 
search criteria. 
 
Highlight box: The text field for the Message # filter is highlighted. 
 
Text box: The user is able to type the appropriate Message # 
(9293202) in the Message # text field. If the user types this number 
incorrectly, he or she receives the message, Please try again.   
Reminder: Type 9293202 in the Message # text box. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. 
 
Screen 9: 
 
Search Option One 
 
 Select Search to see your results. 
 
Highlight box: The Search button is highlighted. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. Beneath the filters are two buttons, Search 
and Clear. 
 
Click box: Select the Search button to continue. 
 
Screen 10: 
 
Search Option One Case Results 
 
  Search Criteria Option One Message Results: 
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Notice the Message # entry matches the number that was typed in the 
Message # text box. 
 
The message information displays in two distinct sections: 
  
  Message Header  
  Sub-tabs: Message Body and Companies.   
 
Additional information on the View AD/CVD Message portlet is covered 
in Topic 2: Display AD/CVD Message Information. 
 
Image: The View AD/CVD Message portlet displays on the right side of 
the References page as a result of selecting the Search button in the 
Search AD/CVD Messages portlet. As described above, this portlet is 
divided into three sections: Message Header, Message Body and 
Companies. 
 
Screen 11 
 
Search Option One Clear Results 
 
To clear the results of the first search, select the AD/CVD Messages 
Search, located on the Task Selector to return to the Search AD/CVD 
Message portlet. 
 
Highlight box #1: The AD/CVD Messages hyperlink is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The AD/CVD Messages portlet displays on the right 
side of the page. 
 
Click box: select the AD/CVD Messages Search 
 
Screen 12 
 
Search Option One Clear Results 
 
 Notice the Message # is still visible in the text entry field. 
 
Select the Clear button to clear your previous search. 
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Highlight box #1: The text field for the Mesaage # filter is highlighted. 
 
Highlight box #2: The Clear button is highlighted. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. The Message # entered previously remains on 
the screen. 
 
Click box: Select the Clear button to continue. 
 
Screen 13 
 
Search Option Two 
 
 Use this option in instances where the full message number is not 
available, but there is still a need to search for a message. 
 
Note:  ACE allows the use of wildcards in searches with a minimum of 
four characters for a message number; for example,   9293*. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. The Search AD/CVD Cases portlet displays on the 
right side of the References page.  
 
Screen 14 
 
Search Option Two 
 
 Select the Message # text box, type 9293* and then select the Space 
Bar to continue. 
 
Highlight box: The text field for the Message # filter is highlighted. 
 
Text box: The user is able to type the appropriate partial Message # 
with the asterisk wildcard symbol (9293*) in the Message # text field. 
If the user types this value incorrectly, he or she receives the 
message, Please try again.   
Reminder: Type 9293* in the Message # text box. 
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Image: The Search Messages portlet displays on the right side of the 
References page. 
 
Screen 15 
 
Search Option Two 
 
 Select Message Status drop-down arrow list. 
 
Highlight box: The Message Status drop-down list arrow is highlighted. 
 
Image: The Message AD/CVD Cases portlet displays on the right side 
of the References page. The Message Status drop-down list arrow is on 
the far right side of the Search AD/CVD Message portlet. 
 
Click box: Select the Messages Status drop-down list arrow to 
continue. 
 
Screen 16 
 
Search Option Two 
 
 Select Active from the Message Status drop-down arrow list. 
 
Highlight box: The Active option is highlighted. 
 
Image: The Search AD/CVD Message portlet displays on the right side 
of the References page. The Message Status drop-down list is on the 
far right side of the Search AD/CVD Messages portlet. The user is able 
to select from the drop-down list options displayed, which include 
Active and Inactive. 
 
Click box: Select Active to continue. 
 
Screen 17 
 
Search Option Two 
 
 Select Search to display your results. 
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Only one additional search filter is needed to display the message 
details.  In this example, a partial number and the wildcard were typed 
in the Message # text box and Active was selected in the Message 
Status. 
 
Highlight box: The Search button is highlighted. 
 
Image: The Search AD/CVD Message portlet displays on the right side 
of the References page. Beneath the filters are two buttons, Search 
and Clear. 
 
Click box: Select the Search button to continue. 
 
Screen 18 
 
Search Option Two Results 
 
 After reviewing the search results, select the Clear button to clear 
your search. 
 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. At the bottom of the portlet, Search Results 
display. Page number hyperlinks display below the Search Results. 
 
Click box: Select the Clear button to continue. 
 
Screen 19 
 
 Search Option Three 
 
 The third search option requires selecting three search filters from the 
available text boxes or making selections from the drop-down lists. 
Use this option if the full or partial message or case number is not 
known. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page.  
 
Screen 20 
 



Web-based Training Guide for   Lesson 3 
Forms, Declarations, & AD/CVD Cases Web-based Training  
 

54 

Search Option Three  
 
 Search Option Three: Select the Message Type drop down arrow list. 
 
Highlight box: The drop-down arrow is highlighted. 
 
Image: The Search AD/CVD Message portlet displays on the right side 
of the References page. The Message Type drop-down list is on the far 
right side of the Search AD/CVD Messages portlet.  
 
Screen 21 
 
Search Option Three  
 
 Select the PRE - Preliminary from the Message Type drop-down arrow 
list. 
 
Highlight box: The Pre-Preliminary option is highlighted. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. The Message Type drop-down list is on the far 
right side of the Search AD/CVD Cases portlet. The user is able to 
select from the drop-down list options displayed, which include ARF-
Admin Review Final, ARP–Admin Review Prelim, ENF–Enforcement, 
FIN-Final Determination, FNO-Final Det w/Order, INF-Information 
Notice, INI-Initiation of Review, INJ-Injunction, INQ-Inquiry, LIQ-
Liquidation, NSR-New Shipper Review, ORD-Order 
 
Click box: Select Pre-Preliminary to continue. 
 
Screen 22 
 
Search Option Three  
 
 Select the Message Date (from) text entry box and type, 01/01/09 
(this will set the start point at the beginning of the calendar year) and 
then select the Space Bar to continue. 
 
Highlight box: The Message Date (from) text box is highlighted. 
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Text box: The user is able to type the appropriate Message Date 
(01/01/09) in the Message Date (from) text box. If the user types this 
date incorrectly, he or she receives the message, Please try again.   
Reminder: Type 01/01/09 in the Message Date (from) text box 
 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. The Message Date (from) text box is on the 
far left side of the Search AD/CVD Messages portlet.  
 
 
Screen 23 
 
Search Option Three  
 Once the from date has been chosen, ACE requires a to date to 
complete the filter. 
 
In the Message Date (to) text entry box type, 11/16/2009 (This will 
set the end date for your search) and then select the Space Bar to 
continue.   
 
Highlight box: The Message Date (to) text box is highlighted. 
 
Text box: The user is able to type the appropriate Message Date 
(11/16/09) in the Message Date (to) text box. If the user types this 
date incorrectly, he or she receives the message, Please try again.   
Reminder: Type 11/16/09 in the Message Date (to) text box 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. The Message Date (to) text box is on the far 
left side of the Search AD/CVD Messages portlet.  
 
Screen 24 
 
Search Option Three  
 In the Message Title (RE:) text box type, Notice and then select the 
Space Bar to continue. 
 
Highlight box: The Message Title (RE:) text box is highlighted. 
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Text box: The user is able to type the appropriate Message title in the 
Message title text box. If the user types this date incorrectly, he or she 
receives the message, Please try again.   
Reminder: Type Notice in the Message Title text box 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. The Message Title text box is on the far right 
side of the Search AD/CVD Messages portlet.  
 
Screen 25 
 
Search Option Three  
 
 Select Search to display your results. 
 

Highlight box: The Search button is highlighted. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. Beneath the filters are two buttons, Search 
and Clear. 
 
Click box: Select the Search button to continue. 
 
Screen 26 
 
Search Option Three Results 
 
 In the example shown here, PRE- Preliminary was selected in the 
Message Type text box, Active was selected in the Message Status text 
box, and a date range was used in the Message Date (to and from).  
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. At the bottom of the portlet, Search Results 
display.  
 
Screen 27 
 
Search Summary 
 
 To effectively locate an AD/CVD message, remember the following: 
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The complete seven digit message number is the only filter you need 
in order to display a message. 
 
Partial message numbers, with a minimum of four characters and the 
wildcard, require one other filter. 
 
If you do not know the message number, a minimum of two filters are 
required to perform a search. 
 
The Message Date (to) and the Message Date (from) fields are 
considered one filter and both must be used in order to complete a 
search. 
 
Message Title only requires a minimum of 4 characters with no 
wildcard.  Using a wildcard for this filter will result in a ‘No Data Found’ 
message. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page.  
 

Screen 28 
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
Which of the following search criteria could you use to search for a 
message? 
 
A) Complete message number. 
 
B) Partial message number along with the wild card (*) and one other 
search criteria. 
 
C) Three search criteria into text boxes or two search criteria into text 
boxes and a selection from a drop-down list. 
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D) All of the above 
 
 The correct answer is D.  
 
Image:  Pencil filling in an answer on a standardized test. 
               
Screen 29 
 
Summary 
 
 Congratulations!  You have completed Topic 1: Search AD/CVD 
Messages.  You now have the knowledge necessary to: 
 
Use various search filters to locate an AD/CVD message in ACE. 
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Topic 2: Display AD/CVD Message Information 
 
Screen 1:  
 
Title Screen 

 
 AD/CVD Case Management  - Display AD/CVD Message Information 
 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
  
Screen 2:   
 
 Objectives 
 
Upon completion of this topic, Display AD/CVD Messages Information, 
you will be able to: 
 
Display and identify key fields in the Message Header, Message Body 
and Companies sub-tabs. 
 
Select the Start button to begin 
 
Image: Computer screen displaying ACE screen. 
 
Screen 3:  
 
Display a Message 

 
 Once the search criteria is entered, display message details by: 
 

1. Selecting the Search button to display the Search Results listing. 
2. Selecting the specific message number hyperlink in the Search 

Results listing. 
 

Image: References page in the ACE Portal. This page is divided into 
two portlets. The Task Selector portlet is on the left side of the screen. 
The task selected from the Task Selector portlet displays in a portlet 
on the right side of the screen. Tasks are listed as hyperlinks in the 
Task Selector portlet. The tasks displayed are: HTS, Tariff History, 
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Port, Gold Rate, Currency Exchange, Country Code, MID, UN Loc Code, 
AD/CVD Cases Search, and AD/CVD Messages Search. 
 
Screen 4:  
 
Display a Message 

 
 To display the Search AD/CVD Messages portlet, select the AD/CVD 
Messages Search hyperlink in the Task Selector portlet. 
 
Highlight box: The AD/CVD Messages Search hyperlink is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. 
 
Click box: Select the AD/CVD Messages Search hyperlink to continue. 
 
 
Screen 5:  
 
Display a Message 

 
 Select the Message # text box, type 9293201 and then select the 
Space Bar to continue. 
 
Highlight box: The text field for Message # is highlighted. 
 
Text box: The user is able to type the appropriate Message # 
(9293201) in the Message # text field. If the user types this number 
incorrectly, he or she receives the message, Please try again.   
Reminder: Type 9293201 in the Message # text box. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. 
 
Screen 6:  
 
Display a Message 

 
 Select Search to display your results. 
 
Highlight box: The Search button is highlighted. 
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Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. Beneath the filters are two buttons, Search 
and Clear. 
 
Click box: Select the Search button to continue. 
 
Screen 7:  
 
Task Selector Navigation – Messages 
 
 You also have the option to select the Messages hyperlink, located in 
the Task Selector portlet, to view any messages associated with the 
displayed case. 
  
If you navigate away from the search results screen and then want to 
return, simply select the Message Details hyperlink and ACE displays 
the results of the last message search. 
 
Image: The View AD/CVD Message portlet displays on the right side of 
the References page. This portlet lists the details of the AD/CVD 
message that resulted from your search. 
 
Screen 8:  
 
Overview 
 
 The AD/CVD message information in the AD/CVD Message portlet 
consists of the Message Header and two sub-tabs: Message Body and 
Companies.  Information pertaining to the message body and 
companies displays when you select each of the sub-tabs. 
 
Highlight box #1: The Message Header is highlighted. 
 
Highlight box #2: The Message Body and Companies sub-tabs 
are highlighted. 
 
Image: The View AD/CVD Message portlet displays on the right side of 
the References page. As described above, this portlet is divided into 
the Message Header at the top of the screen, and the Message Body 
and Companies sub-tabs towards the middle of the screen. 
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Screen 9:  
 
Overview 
 
  
Highlight box: The Message Header section is highlighted. 
 
Image: Zoomed in image of the Message Header section of the View 
AD/CVD Message portlet.  
 
Screen 10:  
 
Overview 
 
The Message Header contains important details about the message.  
 
Select each message field to view more details. 
 
Rollover #1: Message #  
Message # - Displays the CBP approved message which is assigned by 
ACE based on Julian calendar date.  
 
Rollover #2: Case # (s) 
Case # (s) - Lists up to six case numbers that are separated by 
commas. 
 
Rollover #3: Reference Message # (s) 
Reference Message # (s) - Shows other messages that are related to 
the displayed message. Up to six reference numbers can be displayed, 
separated by commas.  Hyperlinks allow quick access to the message 
details portlet. 
 
Rollover #4: Message Title (RE:) 
Message Title (RE:) - Displays the text entered in the RE: line of the e-
mail used to send the message.  
 
Rollover #5: Message Type 
Message Type - Displays the type of message. 
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Rollover #6: Message Subtype 
Message Subtype - Shows the subtype of the message. 
 
Rollover #7: Category 
Category - Shows Antidumping or Countervailing. 
 
Rollover #8: Access Type 
Access Type - Defaults to Public. 
 
Rollover #9: POR (Begin) 
POR (Begin) - Displays the beginning date of the first Period of Review 
(POR). 
 
Rollover #10: POR (End) 
POR (End) - Displays the end date of the first Period of Review (POR). 
 
Rollover #11: Period Covered (Begin) 
Period Covered (Begin) - Displays the beginning date of the second 
Period of Review (POR.) 
 
Rollover #12: Period Covered (End) 
Period Covered (End) - Displays the end date of the second Period of 
Review (POR). 
 
Rollover #13: Message Status 
Message Status - Displays Active or Inactive. 
 
Rollover #14: Message Date 
Message Date - Lists  the system date when the message was 
approved. 
 
Rollover #15: Inactive Date 
Inactive Date - Lists the date message was inactivated. 
 
Rollover #16: Effective Date 
Effective Date - Lists the effective date of the public message. 
 
Rollover #17: FR Cite 
FR Cite - Shows the Federal Register Citation volume and page. 
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Rollover #18: FR Cite Date 
FR Cite Date - Displays the date of the Federal Register Citation. 
Rollover #19: Court # 
Court # - Displays the court order number. 
 
Rollover #20: Lifting of Suspension Date 
Lifting of Suspension Date - Shows the date when the suspension was 
lifted. 
 

Highlight box: The individual fields, described in the rollovers above, 
are highlighted. 
 
Image: Zoomed in image of the Message Header section of the View 
AD/CVD Message portlet.  
 
 
Screen 11:  
 
Message Body Sub-Tab 
 
 The Message Body sub-tab displays the full content of the message.  
A maximum of 150,000 characters and up to 46 pages can display in 
the message body. 
 
A View as a PDF hyperlink is also available and will display the header 
and message information as a PDF with an option to print.  Printing 
messages is discussed in Topic 3, Print AD/CVD Message Information. 
 
Select the Companies sub-tab to look at the companies associated 
with this message.   
 
Highlight box: The Companies sub-tab is highlighted. 
 
Image: The View AD/CVD Message portlet displays on the right side of 
the References page. Beneath the Message Header section are the 
Message Body and Companies sub-tabs. 
 
Click box: Select the Companies sub-tab to continue. 
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Screen 12:  
 
Companies Sub-Tab 
 
 This sub-tab displays company information.  This sub-tab contains 
information on the Case #, Rate used to calculate AD/CVD duties, 
Party IND (Party IND is either M = manufacturer or E = exporter), 
Party ID and Party Name. 
 
Select the Message Body sub-tab.   
 
Highlight box: The Message Body sub-tab is highlighted. 
 
Image: The View AD/CVD Message portlet displays on the right side of 
the References page. Beneath the Message Header section are the 
Message Body and Companies sub-tabs. 
 
Click box: Select the Message Body sub-tab to continue. 
 
Screen 13:  
 
Companies Sub-Tab 
 
 By using the scroll bar the reviewer can view the complete message 
under the Message Body tab.  
 
Highlight box: The scroll bar is highlighted. 
 
Image: The View AD/CVD Message portlet displays on the right side of 
the References page. Beneath the Message Header section the 
Message Body sub-tab is active. There is a scroll bar to the far right of 
the Message Body sub-tab’s content. 
 
Screen 14:  
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
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Where in ACE would you find other messages related to a message 
being displayed? 
 
A) Message Body 
 
B) Companies 
 
C) Message Header 
 
D) None of the Above 
 
The correct answer is C.  
 
Image:  Pencil filling in an answer on a standardized test. 
 
Screen 15: 
 
Knowledge Check Question 2 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
Where would you go to display AD/CVD Messages? 
 
A) Account tab 
 
B) Task Selector portlet 
 
C) Administrative Review sub-tab under Case Management 
 
D) References tab 
 
 The correct answer is B.  

 
Image:  Pencil filling in an answer on a standardized test. 
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Screen 16: 
 
Summary 
 
 Summary 
 
Congratulations!  You have completed Topic 2: Display AD/CVD 
Message Information.  You now have the knowledge necessary to: 
 
Display and identify key fields in the Message Header, Message Body 
and Companies sub-tabs. 
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Topic 3: Print AD/CVD Message Information 
 
Screen 1:  
 
Title Screen 

 
 AD/CVD Case Management  - Print AD/CVD Message Information 
 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
Screen 2:   
 
 Objectives 
 
Upon completion of this topic, Print AD/CVD Messages Information, 
you will be able to: 
 
Print AD/CVD Message information. 
 
Save a file of AD/CVD Message information. 
 
Select the Start button to begin 
 
Image: Computer screen displaying ACE screen. 
 
Screen 3:  
 
Overview 
 
 Topics 1 and 2 demonstrated how to search and display message 
information.  This topic will focus on printing or saving message 
information. 
 
The View as a PDF hyperlink is available in the Message Body and will 
display the header and company information with an option to print 
and save the information. 
 
Image: References page in the ACE Portal. This page is divided into 
two portlets. The Task Selector portlet is on the left side of the screen. 
The task selected from the Task Selector portlet displays in a portlet 
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on the right side of the screen. Tasks are listed as hyperlinks in the 
Task Selector portlet. The tasks displayed are: HTS, Tariff History, 
Port, Gold Rate, Currency Exchange, Country Code, MID, UN Loc Code, 
AD/CVD Cases Search, and AD/CVD Messages Search. 
 
Screen 4:  
 
Print a Message 
 
 To display the Search AD/CVD Messages portlet, select the AD/CVD 
Messages Search hyperlink in the Task Selector portlet. 
 
Highlight box: The AD/CVD Messages Search hyperlink is highlighted. 
 
Image: The Task Selector portlet displays on the left side of the 
References page. 
 
Click box: Select the AD/CVD Messages Search hyperlink to continue. 
 
Screen 5:  
 
Print a Message 
 
 Select the Message # text box, type 9235201 and then select the 
Space Bar to continue. 
 
Highlight box: The text field for Message # is highlighted. 
 
Text box: The user is able to type the appropriate Message # 
(9235201) in the Message # text field. If the user types this number 
incorrectly, he or she receives the message, Please try again.   
Reminder: Type 9235201 in the Message # text box. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. 
 
Screen 6:  
 
Print a Message 
 
 Select Search to display your results. 
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Highlight box: The Search button is highlighted. 
 
Image: The Search AD/CVD Messages portlet displays on the right side 
of the References page. Beneath the filters are two buttons, Search 
and Clear. 
 
Click box: Select the Search button to continue. 
 
Screen 7:  
 
Print a Message 
 
 Select the Companies hyperlink. 
 
Highlight box: The Companies sub-tab is highlighted. 
 
Image: The View AD/CVD Message portlet displays on the right side of 
the References page. Beneath the Message Header section are the 
Message Body and Companies sub-tabs. 
 
Click box: Select the Companies hyperlink (within the Companies sub-
tab) to continue. 
 
Screen 8:  
 
Print a Message 
 
 Select the View as PDF hyperlink.   
 
Highlight box: The View as PDF hyperlink is highlighted. 
 
Image: The View AD/CVD Message portlet displays on the right side of 
the References page. Beneath the Message Header section the 
Companies sub-tab is active. The View as PDF hyperlink is to the far 
right of the Companies sub-tab’s content. 
 
Screens 9 & 10:  
 
Print and Save PDF Message 
 
 In the message PDF, the following options are available: 
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Select the Save icon to save the PDF to your local computer.  
Select the Printer icon to print the PDF. 
 
Image: A separate window displays the PDF (Printer Definition File) 
image of the AD/CVD Message over the ACE Portal. 
 
Screen 11:  
 
Print and Save PDF Message 
 
 Select the Printer icon. 
 
Highlight box: The Printer icon is highlighted. 
 
Image: A separate window displays the PDF (Printer Definition File) 
image of the AD/CVD Message over the ACE Portal. The Printer icon is 
located in the top left corner of the window. 
 
Click box: Select the Printer icon to continue. 
 
Screen 12:  
 
Print and Save PDF Message 
 
 The Print pop-up window displays.  Select the OK button. Your 
document will print to a local printer. 
 
Highlight box: The Print button is highlighted. 
 
Image: The Print pop-up window displays.  
 
Click box: Select the Print button to continue. 
 
Screen 13:   
 
Print and Save PDF Message 
 
 Select the Save icon. 
 
Highlight box: The Save icon is highlighted. 
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Image: A separate window displays the PDF image of the AD/CVD 
Message over the ACE Portal. The Save icon is located in the top left 
corner of the window, to the right of the Printer icon. 
 
Click box: Select the Save icon to continue. 
 
 
Screen 14:   
 
Print and Save PDF Message 
 
 After naming your file select the Save button.   

 
Highlight box: The Save button is highlighted. 
 
Image: The Save a Copy… pop-up window displays. The Save button is 
in the lower right corner of this window. 
 
Click box: Select the Save button to continue. 
 
Screen 15:   
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
Which option allows you to save message information to your 
computer? 
 
A) Message Body 
 
B) Companies 
 
C) Message Header 
 
D) View as PDF 
 
 The correct answer is C.  
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Image:  Pencil filling in an answer on a standardized test. 
 
Screen 16: 
 
Summary 
 
 Summary 
 
Congratulations!  You have completed Topic 3: Print AD/CVD Message 
Information.  You now have the knowledge necessary to: 
 
Print AD/CVD Message information. 
 
Save a file of AD/CVD Message information. 
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Lesson 4: Declarations 
 

Topic 1: Maintain Blanket Declarations for Portal 
Accounts 
 
Screen 1: 
 
Title Screen 

 
 Maintain Blanket Declarations for Portal Accounts 
 
Image: ACE logo with Maintain Blanket Declarations for Portal 
Accounts text – Providing the right information to the right people at 
the right time. 
 
 Screen 2: 
 
Objectives 

 
 Upon completion of this topic, Maintain Blanket Declarations for Portal 
Accounts, you will be able to: 
 
Recognize modifications to the blanket declaration search functionality. 
 
Select the Start button to begin 
 
Image: Computer screen displaying ACE screen. 
 
 Select Start button, in lower right corner of screen, to begin. 
              
Screen 3: 
 
 Display Blanket Declaration Records for Portal Accounts 
 
As an importer with an ACE Portal account, you will notice that with 
this release modifications have been made to the blanket declarations 
search and display functionality as follows: 
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The amount of case numbers that can be associated with a blanket 
declaration record has increased from 1 to 50 to reduce the number of 
declaration records that need to be created. 
 
The number of manufacturer identification (MID) numbers has 
increased from 20 to 50 to allow the declaration record to cover 
additional entry summaries. 
  
10-digit case numbers contain a hyperlink to make it easier to access 
the details of an AD/CVD case. 
 
Image: Cargo ship pulling into port stacked with containers 
 
Screen 4: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
 Select the View drop-down list arrow 
As an importer with an ACE Portal account, you have logged into the 
ACE Portal and selected the Accounts tab.  
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets. The Task Selector portlet is on the top left side of the screen. 
The task selected from the Task Selector portlet displays in a portlet 
on the right side of the screen. The View drop-down list arrow is at the 
top of the Task selector portlet. 
 
Screen 5: 
 
Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
 Select Importer 
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets. The Task Selector portlet is on the top left side of the screen. 
The task selected from the Task Selector portlet displays in a portlet 
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on the right side of the screen. The Importer is in the middle of the 
View drop-down list of the Task selector portlet. 
 
 Screen 6: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
  Select GO 
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets. The Task Selector portlet is on the top left side of the screen. 
The task selected from the Task Selector portlet displays in a portlet 
on the right side of the screen. The Go button is located to the right of 
the View drop-down list of the Task selector portlet. 
 
Screen 7: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
  Select Declarations 
 
From the Task Selector portlet, select the Declarations hyperlink. 
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets. The Task Selector portlet is on the top left side of the screen. 
The task selected from the Task Selector portlet displays in a portlet 
on the right side of the screen. The Declarations hyperlink is located in 
a column under Accounts in Select Tasks. 
 
 Screen 8: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
  Once you select the Declarations hyperlink, the Portal Account and 
Non-Portal Account options display. As an importer with an ACE Portal 
account, you will not have access to the Non-Portal Account option.  
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Select Portal Account 
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets Task Selector, Account Selector. The Task Selector portlet is 
on the top left side of the screen. The task selected from the Task 
Selector portlet displays in a portlet on the right side of the screen. 
The arrow is directed at the Portal Account hyperlink in the Task 
selector portlet. 
 
 Screen 9: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
  Select 0000000571 
 
To begin a review of the new navigational options for this release, 
select the hyperlinked Declaration Number, 0000000571. 
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets. The Declarations portlet is in the middle of the screen. The 
Declaration number to choose is located in the middle of the screen 
towards the bottom. 
 
Screen 10: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
  You are viewing the Declaration portlet that contains information 
about the declaration. The case number associated with this record 
displays in the Case# sub-tab.  
 
Select A-570-890-001 
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets. The Declarations portlet is in the middle of the screen. The 
Case# sub-tab with case numbers to choose is located in the middle of 
the screen towards the bottom. 
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 Screen 11: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
  Select the Accounts tab 
 
You are now viewing the View AD/CVD Company portlet which 
contains the Company Header section and the sub-tabs for the case. 
To return to the Declarations portlet, select the Accounts tab. 
 
Image: References page in the ACE Portal. This page is divided into 
two portlets. The Task Selector portlet is on the left of the screen and 
the View AC/CDV Company potlet is on the right of the screen. 
 
 Screen 12: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
  Select OK 
 
You are back at the Declaration portlet. To return to the Search 
Results section, select OK.  
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets. The Declaration portlet is in middle of the screen under the 
Top Account Summary portlet. The OK button is located at the bottom 
of the screen in the Declaration portlet. 
 
 Screen 13: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
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  You have returned to the Declarations portlet view that contains the 
Search Results. With this release, 10-digit case numbers are now 
hyperlinks. Select the highlighted Case # to display case information. 
 
Select A-570-890-001 
 
Image: Image: Accounts page in the ACE Portal. This page is divided 
into four portlets. The Declarations portlet is in the middle of the 
screen under the Top Account Summary portlet. Case numbers are 
located under the Case # column towards the bottom of the screen in 
the Declarations portlet. 
 
Screen 14: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
  Select the Accounts tab 
 
You have once again displayed the View AD/CVD Company portlet 
which contains the Company Header section and the sub-tabs for the 
case. To return to the Declarations portlet, select the Accounts tab. 
 
Image: References page in the ACE Portal. This page is divided into 
two portlets. The Task Selector portlet is on the left of the screen and 
the View AC/CDV Company potlet is on the right of the screen. 
 
Screen 15: 
 
Forms, Declarations, & AD/CVD Cases 
 
Maintain Blanket Declarations for Portal Accounts 
 
  You have returned to the view that contains the Search Results. 
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets. The Declarations portlet is in the middle of the screen under 
the Top Account Summary portlet. Search results are located under 
Serach Results the towards the bottom of the screen in the 
Declarations portlet. 
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Screen 16: 
 
Knowledge Check  
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
The hyperlinked 10-digit case number allows you to ______? 
 
A) View detailed AD/CVD case information for Non-Portal accounts 
B) View detailed AD/CVD case information for Portal accounts 
C) View detailed AD/CVD case information for Portal and Non-Portal 
accounts 
D) None of the above 
 
 The correct answer is C.  

 
Image:  Pencil filling in an answer on a standardized test. 
 
Screen 17: 
 
Summary 
 
 Summary 
 
Congratulations!  You have completed Topic 1: Maintain Blanket 
Declarations for Portal Accounts. You now have the knowledge 
necessary to: 
 
Recognize modifications to the blanket declaration search functionality. 
 
Image: Computer screen displaying ACE screen. 
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Topic 2: Create a Blanket Declaration for Non- Portal 
Accounts 
 
Screen 1:  
 
Title Screen 

 
 Declarations 
 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
 Screen 2:   
 
 Objectives 
 
Upon completion of this topic, Create a Blanket Declaration Record for 
a Non-Portal Account, you will be able to: 
 
Create a blanket declaration record for a Non-Portal account. 
 
Select the Start button to begin 
 
Image: Computer screen displaying ACE screen. 
 
Screen 3:  
 
What Are Blanket Declaration Records? 
 
 Blanket declarations are statements that support a claim about 
imported merchandise and are created by the importer or the 
importer’s agent. 
 
Blanket declarations must be supported by documents or an electronic 
equivalent and must accompany the entry summary package or be 
available upon demand by CBP.  
 
ACE allows for the creation and storage of blanket declaration records. 
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A blanket declaration record created in the ACE Portal can support 
both ACE and ACS entry summaries. 
 
With this release, brokers with an ACE Portal account can now create 
blanket declaration records for Non-Portal accounts. 
 
Image: Globe displaying North America. 
 
 Screen 4:  
 
Types of Blanket Declarations 
 
 The following declaration types are supported within the ACE Portal. 
Select each declaration type to view more information. 
 
Rollover #1: Affidavit of Manufacture 
An Affidavit of Manufacture supports an Importer statement or 
certificate of origin. It is submitted by the producer of the raw 
materials that are used in an article in which a preference claim for 
duty is made. The intended use of the declaration is not associated 
with HTS 9802. 
Mandatory fields include: Declaration Type, Filer #, Date Valid From, 
Manufacture ID #, HTS#, and IR#. 
 
Rollover #2: Importer Certifying Statement 
An Importer Certifying Statement declares that the merchandise 
qualifies for a Free Trade Agreement or tariff preference program 
because it meets the qualifications. It is not a requirement for the 
entry summaries, but can be helpful with multiple shipments of the 
same goods within a 12-month period. 
 
Mandatory fields include: Declaration Type, Date Valid From, Date 
Valid To, Filer #, IR #, Manufacture ID# and HTS #. 
 
Rollover #3: Non-Reimbursement Blanket Statement (AD/CVD) 
A Non-Reimbursement Blanket Statement states that the importer has 
not been reimbursed by the manufacturer, producer, seller, or 
exporter for antidumping or countervailing duties. You are not required 
to scan and attach a copy of the non-reimbursement certificate, but 
CBP may ask for it.  
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A blanket statement of reimbursement is only good for up to 12 
months or the administrative review period, whichever ends first. If 
reimbursement has not occurred, the trade should check the “All 
Manufacturers” check box rather than enter specific case numbers to 
protect against inadvertent clerical errors. If reimbursement has 
occurred, the trade should enter specific case numbers making sure 
not to include those case numbers where reimbursement has occurred. 
 
Mandatory fields include: Declaration Type, Filer #, Date Valid From, 
Date Valid To, IR #, Case #, All MID #. You are also required to select 
the AD/CVD Non-Reimbursement Statement check box. 
 
Rollover #4: North American Free Trade Agreement (NAFTA) 
Certificate of Origin 
The NAFTA Certificate of Origin is completed by the exporter stating 
that the merchandise qualified for NAFTA because the shipment meets 
specific requirements. The certificate must be attached to the 
declaration within the ACE Portal in order to be valid. 
 
Mandatory fields include: Declaration Type, Date Valid From, Date 
Valid To, Filer #, IR #, and HTS #. 
The following declaration types are supported within the ACE Portal. 
Select each declaration type to view more information. 
 
Image: Silhouettes of seven people in business attire standing in front 
of a map of the world.  
 
Screen 5:  
 
Key Points 
 
 Maximum number of AD/CVD Non Reimbursement Blanket Statement 
Case numbers is 50. 
 
Maximum number of Manufacture ID (MID) numbers per declaration 
record is 50. 
 
Maximum number of Harmondized Tariff Schedule (HTS) numbers per 
declaration record is 50. 
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The maximum number of search results for returned declaration record 
is 500. 
 
Image: A key.  
 
Screen 6:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 To begin, select the View drop-down list arrow. 
Select the View drop-down list arrow. 
 
Highlight box: The View drop-down list arrow is highlighted. 
 
Image: Accounts page in the ACE Portal. This page is divided into four 
portlets. The Task Selector portlet is on the top left side of the screen. 
The task selected from the Task Selector portlet displays in a portlet 
on the right side of the screen. The View drop-down list arrow is at the 
top of the Task selector portlet. 
 
Click box: Select the View drop-down list arrow to continue. 
 
 
Screen 7:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Brokers who create declarations for their Non-Portal accounts must 
first select Importer from the View drop-down list. 
 
Highlight box: The Importer option in the View drop-down list is 
highlighted. 
 
Image: The View drop-down list in the Task selector portlet is 
expanded. The user is able to select from the drop-down list options 
displayed, which include Broker, Carrier, Cartman, Driver/Crew, FTZ 
Operator, Facility Operator, Filer, Importer, Lighterman, Surety, 
Service Provider, Shipper, Consignee. 
 
Click box: Select the Importer option in the View drop-down list to 
continue. 
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Screen 8:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Select GO 
 
Highlight box: The GO button, next to the View drop-down list, is 
highlighted. 
 
Image: The View drop-down list in the Task selector portlet is 
minimized and the Importer view is selected. The GO button is next to 
the View drop-down list. 
 
Click box: Select the GO button in the Task selector portlet to 
continue. 
 
Screen 9:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 From the Task Selector portlet, select the Declarations. 
 
Select Declarations 
 
Highlight box: The Declarations hyperlink, in the Task Selector portlet, 
is highlighted. 
 
Image: The Task selector portlet contains a Select Task section below 
the View drop-down list. Tasks are listed as hyperlinks. The tasks 
displayed are: Create Importer, Change History, Reports, BAL, Action 
Plan, Bonds, Statements, LPCs, Declarations, and Mode of 
Communication. 
 
Click box: Select the Declarations hyperlink in the Task selector portlet 
to continue. 
 
Screen 10:  
 
Create a Blanket Declaration for a Non-Portal Account 
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 Once you select the Declarations, ACE displays the Portal Account and 
Non-Portal Account options. Select the Non-Portal Account option. 
 
Select Non-Portal Account 
 
Highlight box: The Non-Portal Account hyperlink, in the Task Selector 
portlet, is highlighted. 
 
Image: The Declarations task, in the Task Selector portlet, is 
expanded and displays two sub-options; Portal Account and Non-Portal 
Account. 
 
Click box: Select the Non-Portal Account hyperlink in the Task selector 
portlet to continue. 
 
Screen 11:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 You can now select the Create button located in the Declarations 
portlet. 
 
Select the Create button 
 
Highlight box: The Create button, in the Declarations portlet, is 
highlighted. 
 
Image: Accounts page in the ACE Portal. The view displayed is the 
Importer view. This view is divided into three portlets; The Task 
Selector portlet and the Account Selector List portlet on the left, and 
the Declarations portlet on the right. The Declarations portlet contains 
three sections; Moving throught the portlet from top to bottom, the 
sections are Add Declaration, Filter Declarations, and Search Results. 
The Create button is in the Add Declaration section of the Declarations 
portlet. 
 
Click box: Select the Create button, in the Declarations portlet, to 
continue. 
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Screen 12:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Creating a blanket declaration record is a three step process. Notice 
that Step 1: Declarations Details is highlighted. To begin the process 
of adding a blanket declaration, select the Declaration Type drop-down 
list arrow. 
 
Select the Declaration Type drop-down list arrow 
 
Highlight box: The Declaration Type drop-down list arrow, in the 
Create Declaration portlet, is highlighted. 
 
Image: The Declarations portlet has been replaced with the Create 
Declaration portlet. This portlet contains a number of text fields and 
drop-down menus. At the top of the portlet, three steps are listed and 
shaded in to demonstrate where the user is in the process for creating 
the Declaration. These steps are: 
 
Step 1: Declaration Details (currently shaded to show that we are at 
this stage) 
Step 2: Attach File 
Step 3: Review 
 
Click box: Select the Declaration Type drop-down list arrow, in the 
Create Declaration portlet, to continue. 
 
Screen 13:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 From the list of declaration types, select Non-Reimbursement Blanket 
Statement (AD/CVD). 
 
Select Non-Reimbursement Blanket Statement (AD/CVD) 
 
Highlight box: The Non-Reimbursement Blanket Statement (AD/CVD) 
option, in the Declaration Type drop-down list, is highlighted. 
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Image: The Declaration Type drop-down list is expanded. The user is 
able to select from the drop-down list options displayed, which include 
Affidavit of Manufacture, Certain Marking Rulings (CROSS), Importer 
Certifying Statement, Non-Reimbursement Blanket Statement 
(AD/CVD), North American Free Trade Agreement Certificate of Origin. 
 
Click box: Select the Non-Reimbursement Blanket Statement 
(AD/CVD) option, in the Declaration Type drop-down list, to continue. 
 
Screen 14:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Select the Filer drop-down list arrow 
 
Highlight box: The Filer drop-down list arrow, in the Create Declaration 
portlet, is highlighted. 
 
Image: Below the Declaration Type drop-down list is the Filer drop-
down list.  
 
Click box: Select the Filer drop-down list arrow, in the Create 
Declaration portlet, to continue. 
 
Screen 15:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 From the Filer drop-down list, select A4Q. 
 
Highlight box: The A4Q option, in the Filer drop-down list, is 
highlighted. 
 
Image: The Filer drop-down list is expanded. The user is able to select 
from the drop-down list options displayed, which include –Select–, and 
A4Q. 
 
Click box: Select the A4Q option, in the Filer drop-down list, to 
continue. 
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Screen 16:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Select the IR# text box, type 84-562584857, and then press the 
Space Bar. 
 
Highlight box: The text field for IR# is highlighted. 
 
Text box: The user is able to type the appropriate IR # (84-
562584857) in the IR # text field. If the user types this number 
incorrectly, he or she receives the message, Please try again. 
Reminder: Type 84-562584857 in the IR # text box. 
 
Image: Below the Filer # drop-down list is the IR# text box. 
 
Screen 17:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Select the Date Valid From text box, type 07/10/2008, and then press 
the Space Bar. 
 
Highlight box: The text field for Date Valid From is highlighted. 
 
Text box: The user is able to type the appropriate Date Valid From 
(07/10/2008) in the Date Valid From text field. If the user types this 
number incorrectly, he or she receives the message, Please try again.   
Reminder: Type 07/10/2008 in the Date Valid From text box. 
 
Image: Below the IR# text box is the Date Valid From text box. 
 
Screen 18:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Select the Date Valid To text box, type 10/08/2010, and  then press 
the Space Bar. 
 
Highlight box: The text field for Date Valid To is highlighted. 
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Text box: The user is able to type the appropriate Date Valid To 
(10/08/2010) in the Date Valid To text field. If the user types this 
number incorrectly, he or she receives the message, Please try again. 
Reminder: Type 10/08/2010 in the Date Valid To text box. 
 
Image: Below the Date Valid From text box is the Date Valid To text 
box. 
 
Screen 19:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Select the Case # text box, type A-570-890-001 and then press the 
Space Bar. 
 
Highlight box: The text field for Case # is highlighted. 
 
Text box: The user is able to type the appropriate Case # (A-570-890-
001) in the Case # text field. If the user types this number incorrectly, 
he or she receives the message, Please try again. Reminder: Type A-
570-890-001 in the Case # text box. 
 
Image: Below the Date Valid To text box is the Ruling # text box 
followed by the Case # text box. 
 
Screen 20:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Select the All MID #s check box. 
 
Highlight box: The Manufacturer ID # check box is highlighted. 
 
Image: Below the Case # text box is the Manufacturer ID # check 
box. 
 
Click box: Select the Manufacturer ID # check box to continue. 
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Screen 21:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Read the certification statement in order to verify your compliance 
with the AD/CVD Non-Reimbursement and then select the AD/CVD 
Non-Reimbursement Statement check box. 
 
Select the AD/CVD Non-Reimbursement Statement check box 
 
Highlight box: The AD/CVD Non-Reimbursement Statement check box 
is highlighted. 
 
Image: Below the Manufacturer ID # check box are text boxes for HTS 
# and Comments. Below these text boxes is the AD/CVD Non-
Reimbursement Statement check box that relates to the following on-
screen text: I hereby certify that I have not entered into any 
agreement or understanding for the payment or for the refunding to 
me, by the manufacturer, producer, seller, or exporter, of all or any 
part of the antidumping duties or countervailing duties assessed upon 
importations of products subject to this blanket statement of non-
reimbursement. 
 
Click box: Select the AD/CVD Non-Reimbursement Statement check 
box to continue. 
 
Screen 22:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 You are ready to go to Step 2: Attach File. Since you are going to 
attach a document, select the Continue> button. 
 
Select the Continue> button 
 
Highlight box: The Continue> button is highlighted. 
 
Image: Below the AD/CVD Non-Reimbursement Statement are three 
buttons; Continue>, Continue Without Attachments>, and Cancel. 
 
Click box: Select the Continue> button to continue. 
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  Continue> 

      
Screen 23:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 To attach a file, you must first browse out to your local drive in order 
to locate the file you wish to attach. 
 
Select the Browse... button 
 
Highlight box: The Browse... button is highlighted. 
 
Image: The Create Declaration portlet is still displayed, but the view is 
now of the Step 2: Attach File fields and buttons. At the top of the 
portlet, three steps are listed and shaded in to demonstrate where the 
user is in the process for creating the Declaration. These steps are: 
 
Step 1: Declaration Details  
Step 2: Attach File (currently shaded to show that we are at this 
stage) 
Step 3: Review 
 
Click box: Select the Browse... button to continue. 
 
Screen 24:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 In the Choose File to Upload pop-up window, the yellow box indicates 
the file needed to attach to the declaration. 
 
Select the Open button 
 
Highlight box #1: The Blanket Statement of Non-Reimbursement.pdf 
file is highlighted. 
 
Highlight box #2: The Open button is highlighted. 
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Image: The Choose File to Upload pop-up window displays over the 
ACE Portal. This pop-up window is a standard browsing window from 
which the user can locate his or her attachment files. 
 
Click box: Select the Open button to continue. 
 
Screen 25:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 Select the Attach File button 
 
Highlight box: The Attach File button is highlighted. 
 
Image: The Choose File to Upload pop-up window is closed and the 
Create Declaration portlet is displayed with the Step 2: Attach File 
fields and buttons. The Attach File button is to the right of the 
Browse... button. 
 
Click box: Select the Attach File button to continue. 
 
Screen 26:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 The file you selected displays in the Attachments list box. To view the 
file you attached, select the View Attachment button. 
 
To remove any file you attach to the declaration, select the file name 
in the Attachments list box and then select the Remove button. 
 
You can attach multiple files to declaration by repeating the previous 
steps. 
 
Select the Continue button 
 
Highlight box: The Continue> button is highlighted. 
 
Image: At the bottom of the Step 2: Attach File fields and buttons of 
the Create Declaration portlet are three buttons; <Previous, 
Continue>, and Cancel. 
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Click box: Select the Continue> button to continue. 
 
Screen 27:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 The Declaration Information displays and you have now moved to 
Step 3: Review where you have the opportunity to verify the 
information you have entered. 
 
At the bottom of this window, you have three choices. You can select 
the Previous> button to move back to Step 1: Declaration Details 
where you can edit the information you have added. You could select 
the Submit button in order create the declaration with the information 
you have entered or you could select the Cancel button to remove 
your entries. 
 
Select the Submit button 
 
Highlight box: The Submit button is highlighted. 
 
Image: The Create Declaration portlet is still displayed, but the view is 
now of the Step 3: Review fields and buttons. At the top of the portlet, 
three steps are listed and shaded in to demonstrate where the user is 
in the process for creating the Declaration. These steps are: 
 
Step 1: Declaration Details  
Step 2: Attach File  
Step 3: Review (currently shaded to show that we are at this stage) 
 
Click box: Select the Submit button to continue. 
 
Screen 28:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 The Confirmation portlet displays with a message that the declaration 
has been successfully submitted. 
 
Select OK 
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Highlight box: The OK button is highlighted. 
 
Image: The Create Declaration portlet has been replaced with the 
Confirmation portlet. The Confirmation portlet contains basic 
information about the Declaration, including the associated Account 
Name, Account ID#, Declaration #, and Status, as well as the above 
described confirmation message. 
 
Click box: Select the OK button to continue. 
 
Screen 29:  
 
Create a Blanket Declaration for a Non-Portal Account 
 
 You have returned to the Declarations portlet. 
 
Image: The Declarations portlet displays on the right side of the 
Accounts page. 
 
Screen 30:  
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
To create a declaration record for a Non-Portal account, the broker 
must select ____________. 
 
A) The Broker view 
 
B) The Importer view 
 
C) Either the Broker or the Importer view 
 
D) All of the above 
 
 The correct answer is B.  
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Image:  Pencil filling in an answer on a standardized test. 
 
Screen 31: 
 
Summary 
 
 Summary 
 
Congratulations!  You have completed Topic 2: Create a Blanket 
Declaration Record for a Non-Portal Account.  You now have the 
knowledge necessary to: 
 
Create a blanket declaration record for a Non-Portal account. 
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Topic 3: Maintain Blanket Declarations for Non-Portal 
Accounts 
 
Screen 1: 
 
Title Screen 

 
 Declarations  - Maintain Blanket Declarations for Non-Portal Accounts 
 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
Screen 2: 
 
 Objectives 
 
Upon completion of this topic, Maintain Blanket Declarations for Non-
Portal Accounts, you will be able to: 
 
Display blanket declaration records for Non-Portal accounts. 
 
Use search filters to locate a blanket declaration record. 
 
Navigate in Search Results. 
 
Print a blanket declaration record. 
 
Cancel a blanket declaration record. 
 
Select the Start button to begin 
 
Image: Computer screen displaying ACE screen. 
 
Screen 3: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 Brokers with an ACE Portal account will be able to view declaration 
records they have created on behalf on Non-Portal accounts. 
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Access to declaration records is based on privileges granted by the 
Trade Account Owner (TAO) or Proxy Trade Account Owner. 
 
Image: A world globe with figures holding hands forming a circle 
around the globe 
 
 
Screen 4: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 Once you select Non-Portal Account, ACE displays the Declarations 
portlet which contains three sections. 
 
Add Declaration 
Filter Declarations 
Search Results 
 
Select the name of each of these sections to review functional 
information. 
 
Rollover #1: Add Declaration 
Brokers with an ACE Portal Account can create a blanket declaration 
record on behalf of Importers with a Non-Portal account. The Create 
button is covered in Lesson 4: Declarations, Topic 2: Create a Blanket 
Declaration Record for a Non-Portal Account. 
 
Rollover #2: Filter Declarations 
When the amount of blanket declaration records displayed in the 
Search Results section exceeds ten, you can use the filters in the Filter 
Declaration section to quickly locate a declaration record. If the 
required record is displayed in the Search Results, there is no need to 
use the Filters. 
 
Rollover #3: Search Results 
ACE automatically populates the Search Results section which contains 
up to 500 records that a broker has created for Importers without a 
Portal account. These results are displayed in groups of ten with 
navigational page numbers that you can use to access each set of 
additional records. 
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Highlight box: The Add Declarations, Filter Declarations and Search 
Results are highlighted. 
 
Image: The Declarations portlet displays on the right side of the 
References page. The Task Selector portlet is on the far left side of the 
Declarations portlet. Search Results displays at the bottom of the 
Declarations portlet 
 
Screen 5: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 To begin, select the View drop-down list arrow located in the Task 
Selector portlet. 
 
Select the View drop-down list arrow 
 
Highlight box: The View Drop-down list arrow is highlighted. 
 
Image: The View Top Account section displays on the right side of the 
References page. The Task Selector portlet is on the far left side of the 
Declarations portlet with the drop-down arrow under select Account 
type.  
 
Screen 6: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
Select Importer 
 
Brokers who create declarations for their Non-Portal accounts must 
first select Importer from the View drop-down list. 
 
Image: View Top Account is displayed. The Task Selector portlet is on 
the left side of the screen. The task selected from the Task Selector 
portlet displays in a portlet on the right side of the screen. View Drop-
down list includes the following options:  Broker, Carrier, Cartman, 
Driver/Crew, FTZ Operator, Facility Operator, Filer, and Importer. 
 
Click box: Select Importer to continue. 
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Screen 7: 
 
Maintain Blanket Declarations for Non-Portal Accounts   
Select GO 
 
Image: View Top Account is displayed with Importer as the selection.  
 
Click box: Select GO to continue. 
 
Highlight box: GO is highlighted. 
 
Screen 8: 
 
Maintain Blanket Declarations for Non-Portal Accounts   
 
Select Declarations 
 
Image: View Top Account is displayed with Importer as the selection. 
Select task list includes: Create Importer, Change History, Reports, 
BAL, Action Plan, Bonds, Statements, LPC, Declarations, and Mode of 
Communication.  Right-side of screen displays Top Account View. 
 
Click box: Select Declarations to continue. 
 
Highlight box: Declarations is highlighted. 
 

Screen 9: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 Select Non-Portal Account 
 
Once you select the Declarations, ACE displays the Portal Account and 
Non-Portal Account options. 
 
Image: View Top Account is displayed with Importer as the selection. 
Select task list includes: Create Importer, Change History, Reports, 
BAL, Action Plan, Bonds, Statements, LPC, Declarations, and Mode of 
Communication.  Under declarations, 2 sub-options appear:  Portal 
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and Non-Portal.  Right-side of screen displays Declarations Portal.  
Bottom of screen contains search results 
 
Click box: Select Non-Portal Accounts to continue. 
 
Highlight box: Non-Portal Accounts is highlighted. 
 
 

Screen 10: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 ACE automatically displays a listing of up to 10 records in the Search 
Results section.  
 
Select Declaration number 0000040043 
 
Image: View Top Account is displayed with Importer as the selection. 
Select task list includes: Create Importer, Change History, Reports, 
BAL, Action Plan, Bonds, Statements, LPC, Declarations, and Mode of 
Communication.  Under declarations, 2 sub-options appear:  Portal 
and Non-Portal.  Right-side of screen displays Declarations Portal.  
Bottom of screen contains search results 
 
Click box: Select 0000040043 to continue. 
 
Highlight box: Declaration # 0000040043 is highlighted in the search 
Results section. 
 

Screen 11: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 You are now viewing the declaration record. The case number 
associated with this record displays as a hyperlink in the Case # sub-
tab. 
 
From this view, you can:  
Print a declaration using the Print Page hyperlink. 
Cancel a declaration using the Cancel Declaration button. 
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To navigate to the Harmonized Tariff Schedule (HTS) number, select 
the HTS# sub-tab. 
 
Select the HTS # sub-tab 
 
Image: Screen is divided into 3 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and the bottom left is the 
Account Selector List portlet. Below the declarations portlet are 3 sub-
tabs and hyperlinks: Case #, Manufacturers, HTS#, and Attachments 
 
Click box: Select HTS # to continue. 
 
Highlight box: HTS # sub-tab is highlighted 
 

Screen 12: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 The Harmonized Tariff Schedule (HTS) number associated with the 
declaration displays.  
 
To view attachments associated with this declaration, select the 
Attachments sub-tab. 
 
Select the Attachments sub-tab 
 
Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and the bottom left is the 
Account Selector List portlet.  Below the declarations portlet are 3 sub-
tabs and hyperlinks: Case #, Manufacturers, HTS#, and Attachments 
 
Click box: Select Attachments # to continue. 
 
Highlight box: Attachments sub-tab is highlighted 
 
 

Screen 13: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
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 The attachment for this declaration displays. To return to the Search 
Results, select the OK button. 
 
Select OK 
 
Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and the bottom left is the 
Account Selector List portlet.  Below the declarations portlet are 3 sub-
tabs and hyperlinks: Case #, Manufacturers, HTS#, and Attachments 
 
Click box: Select OK to continue. 
 
Highlight box: OK button are the attachment are highlighted.  
Attachment contains Filename, Date Uploaded and Time Uploaded. 
 
 

Screen 14: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 You have returned to the Declarations portlet where the Filter 
Declarations and the Search Results sections are displayed.  
 
Notice the 10-digit case number is a hyperlink. Select case number A-
570-508-002 to display the View AD/CVD Company Header 
Information. 
 
Select Case # A-570-508-002 
 
Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and the bottom left is the 
Account Selector List portlet.  Below the declarations portlet The 
Search Results displays Case#, Ruling#, Status, Valid from and Valid 
to information 
 
Click box: Select A570-508-002 to continue. 
 
Highlight box: Case # A570-508-002 in the Search Results section is 
highlighted. 
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Screen 15: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 The Company Header section contains the Country hyperlink which 
allows you to display country codes.  
 
The View Official Case Name hyperlink allows you to display additional 
information about the AD/CVD case.  
 
This view also contains sub-tabs that are hyperlinks. Selecting any of 
these sub-tabs displays additional information.  
 
To return to the Search Results, select the Accounts tab. 
 
Image: The Main Menu tabs appear: Home, Accounts, References, and 
Tools.  The right side displays the AD/CVD Company portlet. 
 
Click box: Select Accounts to continue. 
 
Highlight box: Accounts tab is highlighted. 
 

Screen 16: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 You are once again returned to the view with the Search Results.  
 
Notice that some of the declarations listed in the table contain a 
reference to Multiple in the Case # column.  
 
This reference indicates that multiple AD/CVD cases are attached to 
this declaration. Select Decl # 0000040044 to view a multiple case 
listing. 
 
Select 0000040044 
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Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and the bottom left is the 
Account Selector List portlet.  Below the declarations portlet The 
Search Results displays Declaration Number, Declaration Type, 
Account ID #, Case# 
 
Click box: Select 0000040044 to continue. 
 
Highlight box: 0000040044 under Declaration Number and Multiple 
under Case # are highlighted. 
 

Screen 17: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 You have displayed the AD/CVD case numbers that are associated 
with this declaration.  
 
Selecting the hyperlink displays the case number associated with the 
declaration. 
 
Select OK 
 
Image: Image: Screen is divided into 4 sections:  Top left is the Task 
Selector Portlet, Far right is the Declarations portlet and the bottom 
left is the Account Selector List portlet.  Below the declarations portlet 
are 3 sub-tabs and hyperlinks: Case #, Manufacturers, HTS#, and 
Attachments 
 
Click box: Select OK to continue. 
 
Highlight box: OK box is highlighted. 
 
 

Screen 18: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 You are returned to the Search Results view.  
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If you have the blanket declaration number, you can search for this 
blanket declaration record by typing the number in the Declaration # 
filter. 
 
Type 0000039707 in the Declaration # text box and press the Space 
Bar. 
 
Text box: The user is able to type the appropriate Declaration 
(0000039707) in the Declarations text field. If the user types this 
name incorrectly, he or she receives the message, Please try again.   
Reminder: Type 0000039707 in the Declaration text box. 
 
Image: Image: Screen is divided into 4 sections:  Top left is the Task 
Selector Portlet, Far right is the Declarations portlet and the bottom 
left is the Account Selector List portlet.  Below the declarations portlet 
The Search Results displays Declaration Number, Declaration Type, 
Account ID #, Case# 
 
Click box: Type 0000039707 to continue. 
 
Highlight box: Declaration is highlighted. 
 

Screen 19: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
 
 Select Filter 
 
Highlight box: The Filter button is highlighted. 
 
Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and the bottom left is the 
Account Selector List portlet.  Below the declarations portlet The 
Search Results displays Declaration Number, Declaration Type, 
Account ID #, Case#, Ruling #, Status, Valid From and Valid to Dates. 
 
Click box: Select the Filter button to continue. 
 

Screen 20: 
 
Maintain Blanket Declarations for Non-Portal Accounts  
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 If you do not have the blanket declaration number, you can search 
using any two filters.  
 
To clear the Filter Declarations section, select the Cancel button. 
 
Select Cancel 
 
Highlight box: The Cancel button as well as information for declaration 
0000039707 are highlighted. 
 
Image: Declarations portlet and Add Declaration section appears.  
Search results displays information for 0000039707, which was used 
earlier. 
 
Click box: Select the Cancel button to continue. 
 

Screen 21: 
 
Maintain Blanket Declarations for Non-Portal Accounts  

 
 Type 10/07/2008 in the Valid From text box and press the Space Bar. 
 
Type the date indicated in the Valid From filter. 
 
Text box: The user is able to type the appropriate valid Date 
(10/07/2008 in the Valid from text box. If the user types this date 
incorrectly, he or she receives the message, Please try again.   
Reminder: Type 10/07/2008 in the Valid from text box 
 
 
Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and Filter Declarations 
section, and the bottom left is the Account Selector List portlet.  Below 
the declarations portlet The Search Results displays Declaration 
Number, Declaration Type, Account ID #, Case#, Ruling #, Status, 
Valid From and Valid to Dates. 
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Screen 22: 
 
Maintain Blanket Declarations for Non-Portal Accounts  

 
 Select the Valid To filter and type the date indicated.  
 
The Valid From and Valid To filters are considered one filter. 
 
Type 07/21/2010 in the Valid To filter and press the Space Bar. 
 
Text box: The user is able to type the appropriate valid Date 
(07/21/2010) in the Valid from text box. If the user types this date 
incorrectly, he or she receives the message, Please try again.   
Reminder: Type 07/21/2010 in the Valid from text box 
 
Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and Filter Declarations 
section, and the bottom left is the Account Selector List portlet.  Below 
the declarations portlet The Search Results displays Declaration 
Number, Declaration Type, Account ID #, Case#, Ruling #, Status, 
Valid From and Valid to Dates. 
 
Screen 23: 
 
Maintain Blanket Declarations for Non-Portal Accounts  

 
 Select the Status drop-down list arrow 
 
You have typed information for one search filter.  
 
To enter the second criteria, move to the Status filter. 
 
Highlight box: The Status drop-down arrow is highlighted. 
 
Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and Filter Declarations 
section, and the bottom left is the Account Selector List portlet.  Below 
the declarations portlet The Search Results displays Declaration 
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Number, Declaration Type, Account ID #, Case#, Ruling #, Status, 
Valid From and Valid to Dates.  
 
Click box: Select the drop-down arrow to continue. 
 
 
Screen 24: 
 
Maintain Blanket Declarations for Non-Portal Accounts  

 
 Select Active 
 
Highlight box: The Status drop-down options are highlighted. 
 
Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and Filter Declarations 
section, and the bottom left is the Account Selector List portlet.  Below 
the declarations portlet The Search Results displays Declaration 
Number, Declaration Type, Account ID #, Case#, Ruling #, Status, 
Valid From and Valid to Dates. The user is able to select from the 
drop-down list options displayed, which include active and cancelled. 
 
Click box: Select active to continue. 
 
Screen 25: 
 
Maintain Blanket Declarations for Non-Portal Accounts  

 
 You have displayed the search results based on the Valid From and 
Valid  
 
To filters which is considered one entry. You also completed the Status 
filter. 
 
Image: Screen is divided into 4 sections:  Top left is the Task Selector 
Portlet, Far right is the Declarations portlet and Filter Declarations 
section, and the bottom left is the Account Selector List portlet.  Below 
the declarations portlet The Search Results displays results based on 
the valid from and to dats as well as a status of active. 
  
Click box:  
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Screen 26: 
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
Brokers can search for and display Non-Portal account blanket 
declaration records from ___________. 
 
A) Any account view. 
 
B) Top accounts only. 
 
C) Top accounts and sub accounts. 
 
D) Sub accounts only. 
 
The correct answer is C. 
 
Image:  Pencil filling in an answer on a standardized test. 
 
Screen 27: 
 
Knowledge Check Question 2 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
Brokers who create blanket declaration records for a Non-Portal 
account can ___________. 
 
A) View the declaration only. 
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B) Print the declaration as a PDF. 
 
C) Save the declaration as a PDF. 
 
D) Do all of the above. 
 
 The correct answer is C.  
 
Image:  Pencil filling in an answer on a standardized test. 
 

 Screen 28: 
 
Knowledge Check Question 3 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
 
Brokers who create blanket declaration records for a Non-Portal 
account must select the ___________ view. 
 
A) Broker 
 
B) Carrier 
 
C) Importer 
 
D) Facility Operator 
 

 The correct answer is C. Check Answer 
 

Screen 29: 
 
Summary 
 
 
You have completed Topic 3: Maintain Blanket Declarations for Non-
Portal Accounts.  You now have the knowledge necessary to: 
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Display blanket declaration records for Non-Portal accounts. 
 
Use search filters to locate a blanket declaration record. 
 
Navigate in Search Results. 
 
Print a blanket declaration record. 
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Lesson 5: AD/CVD Reports 
 

Topic 1: New AD/CVD Entry Summary Reports 
 
Screen 1: 
 
 AD/CVD Reports  - New AD/CVD Entry Summary Reports 
 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
  
Screen 2:   
 
 Objectives 
 
Upon completion of this topic, New AD/CVD Entry summary Reports, 
you will be able to: 
 
Locate and run ESM-8027 Trade Aged Liquidation AD/CVD Entry 
Summary Report. 
Locate and schedule AD-8027 Trade Aged Liquidation AD/CVD Entry 
Summary Extract Report. 
Locate the ACE Portal Reports Dictionary and the Trade Reports User 
Guide. 
 
   Screen 3: 
   
New ACE Reports 
 
 The new ACE reports for the trade for this release are: 
 
ESM-8027 Trade Aged Liquidation AD/CVD Entry Summary Report 
Use this report to display all non-liquidated AD/CVD entry summaries 
as well as those liquidated within the past year. 
This report displays up to 65,000 rows of data. 
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AD-8027 Trade Aged Liquidation AD/CVD Entry Summary Authorized 
Data Extract Report 
Use this report to display all non-liquidated AD/CVD entry summaries 
as well as those liquidated within the past year. 
This report displays up to 1,000,000 rows of data. 
  
Image: CBP officer with a dog sniffing cardboard boxes inside a 
warehouse. 
 

Screen 4: 
 
Information on How to Use the ACE Report Functionality 
 
 If you are unfamiliar with how to run ACE reports, it is recommended 
that you visit: http://nemo.cbp.gov/ace_online and complete the web-
based training, ACE Reports for the Trade Community. 
 
Note: To access this course, use the following information: 
User Name: user01 
Password: 1Password  
 
Image: Screen capture of the ACE Online Web Based Training Menu 
with a listing of options. 
 

Screen 5: 
 
New Reports 
 
Image: ACE Portal Homepage is displayed.  
 
 Once you have Logged into the ACE Portal homepage, select the 
Accounts tab. 
 
Highlight Box: The Accounts tab is highlighted. 
 
Clickbox: Select the Accounts tab to continue. 
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Screen 6: 
 
New Reports 
 
Image: The Accounts tab is displayed with the Task Selector portlet on 
the left. The Task Selector portlet contains two sections, the Select 
Account Type and Select Task. The Account Selector List portlet is 
displayed below the Task Selector portlet on the left. The Account 
Selector List Portlet contains two sections, View Setting and Accounts. 
The View Top Account portlet displays on the right. Below the View 
Top Account portlet is the Broker portlet which is currently blank. 
 
 Importers with an ACE Portal Account must select Importer from the 
View drop-down list and then select GO. 
 
Brokers with an ACE Portal account must accept the Broker default in 
the View drop-down list. 
 
For this practice, you will leave the View drop-down list at Broker. To 
continue, select the Reports hyperlink in the Task Selector section. 
 
Highlight Box: The Reports hyperlink is highlighted. 
 
Click Box: Select the Reports hyperlink to continue. 
 
Select Reports from the Task Selector portlet. 
 

Screen 7: 
 
New Reports 
Image: The Accounts tab is displayed with the Task Selector portlet on 
the left. The Task Selector portlet contains two sections, the Select 
Account Type and Select Task. The Account Selector List portlet is 
displayed below the Task Selector portlet on the left. The Account 
Selector List Portlet contains two sections, View Setting and Accounts.  
The Broker Summary Portlet displays on the right and contains the 
Broker name and ACE ID number. Below the Broker Summary is the 
Launch Reports and Quickview Tool portlet. This portlet contains the 
Launch Tool button.  



Web-based Training Guide for   Lesson 5 
Forms, Declarations, & AD/CVD Cases Web-based Training  
 

116 

 
 Select the Launch Tool 
 
Highlight Box: The Launch Tool button is highlighted. 
 
Click Box: Select the Launch Tool button to continue. 
 

Screen 8: 
 
New Reports 
Image: The Welcome to ACE Reports screen displays 
 
 ACE will launch the ACE Secure Data Portal in a separate window. 
 

Screen 9: 
 
New Reports 
Image: The Welcome to ACE Reports displays with the Folders portlet 
displayed on the left. Located below the Folders portlet is the Home 
icon and below the Home icon are the My Folders and Public Folders 
icons.  

 
 To display a listing of available folders from the Public Folders, select 
the + icon. 
 
Highlight Box: The + icon next to the Public Folders is highlighted. 
 
Click Box: Select the + icon next to Public Folders to continue. 
 

Screen 10: 
 
New Reports 
Image: The Public Folders icon has been expanded and now displays a 
listing of folders. 
 
 To locate the ESM-8027 Trade Aged Liquidation ADCVD Entry 
Summary Report which is new for this release, select the + icon 
adjacent to the Entry Summary folder. 
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Highlight Box: The + icon next to the Entry Summary folder is 
highlighted. 
 
Click Box: Select the + icon next to the Entry Summary folder to 
continue. 
 

Screen 11: 
 
New Reports 
Image: The Entry Summary folder has been expanded and displays a 
listing of entry summary folders. 
 
 ACE displays a listing of the Entry Summary folders. The ESM-8027 
Trade Aged Liquidation ADCVD Entry Summary Report is housed in the 
AD/CVD folder.  
 
Highlight Box: The ADCVD folder is highlighted. 
 
Click Box: Select the ADCVD folder to continue. 
 

Screen 12: 
 
New Reports 
Image: The ESM-8027 Trade Aged Liquidated ADCVD Entry Summary 
Report displays in the ADCVD portlet on the right. 
 
 ACE displays the ESM-8027 Trade Aged Liquidated ADCVD Entry 
Summary Report in the AD/CVD portlet. 
 
Highlight Box: The ESM-8027 Trade Aged Liquidated ADCVD Entry 
Summary Report is highlighted. 
 
 Select the ESM-8027 Trade Aged Liquidated ADCVD Entry Summary 
Report name. 
 
Click Box: Select the ESM-8027 Trade Aged Liquidated ADCVD Entry 
Summary Report to continue. 
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Screen 13: 
 
New Reports 
Image: The Prompts portlet displays with a listing of promtps that can 
be completed in order to run reports. Listings with the green arrows 
are the defaults and listings with the red arrows must be completed in 
order to run the report. 
 
 The Prompts dialog box displays. You must enter the Suspend Entry 
Summary Begin and the Suspend Entry Summary End and the 
Creation Date (begin) and Creation Date (end) dates in order to run 
this report. 
 
Highlight Box: The Suspend ES Effective Date (begin) prompt is 
highlighted. 
 
Click Box: Select the Suspend ES Effective Date (begin) prompt to 
continue. 
 
 Select the Select the Suspend ES Effective Date (begin) prompt. 
   

Screen 14: 
 
New Reports 
Image: The Prompts portlet now displays a Suspend ES Effective Date 
(begin) text box where you can type the date. There is also a calendar 
icon you can use that displays a calendar where you can select the 
date. 
  
 Once you select the Suspend ES Effective Date (begin) prompt, ACE 
displays the Suspend ES Effective Date (begin) text box. 
 
Highlight Box: The Suspend ES Effective Date (begin) text box is 
highlighted. 
 
Text Entry Box: Select the Suspend ES Effective Date (begin) to type 
the date and continue. 
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Text Entry Caption: Select the Suspend ES Effective Date (begin) text 
box, type 06/01/2009 and press the Space Bar to continue. 
 
Failure Caption Text Box: Please try again.   
Reminder: Type 06/01/2009 in the Suspend ES Effective Date (begin) 
text box. 
 

Screen 15: 
 
New Reports 
Image: The Prompts portlet displays with a listing of promtps that can 
be completed in order to run reports. Listings with the green arrows 
are the defaults and listings with the red arrows must be completed in 
order to run the report. 
 
 Select the Suspend ES Effective Date (end) from the Prompts listing. 
 
Highlight Box: The Suspend ES Effective Date (end) text box is 
highlighted. 
 
Click Box: Select the Suspend ES Effective Date (end) text box to 
continue. 
 
 

Screen 16: 
 
New Reports 
Image: The Prompts portlet now displays a Suspend ES Effective Date 
(end) text box where you can type the date. There is also a calendar 
icon you can use that displays a calendar where you can select the 
date. 
 
 Once you select the Suspend ES Effective Date (end) prompts entry, 
ACE displays the Suspend ES Effective Date (end) text box. 
 
Highlight Box: The Suspend ES Effective Date (end) text box is 
highlighted. 
 



Web-based Training Guide for   Lesson 5 
Forms, Declarations, & AD/CVD Cases Web-based Training  
 

120 

Text Entry Caption: Select the Suspend ES Effective Date (end) text 
box, type 11/24/2009 and press the Space Bar to continue. 
 
Failure Caption  Please try again.   
Reminder: Type 11/24/2009 in the Suspend ES Effective Date (end) 
text box. 
  

Screen 17: 
 
New Reports 
Image: The Prompts portlet is displayed and the dates have been 
typed for the Suspend ES Effective (begin) and (end) dates. The 
arrows to the left of these listings are now green. 
 
 After you enter the Suspend ES Effective (end) date, ACE activates 
the Run Query button. Select it now to run this report. 
 
Highlight Box: The Run Query button is highlighted. 
 
Click Box: Select the Run Query button to continue. 
 
 

Screen 18: 
 
New Reports 
Image:  The Folders portlet is displayed on the left. The ESM-8027 
Trade Liquidation ADCVD Entry Summary report is displayed in the 
portlet on the right. 
 
 The ESM-8027 Trade Liquidation ADCVD Entry Summary report 
displays. As stated previously, use this report to display all non-
liquidated AD/CVD entry summaries as well as those liquidated within 
the past year. 
 
Click Box:  
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Screen 19: 
 
New Reports 
Image: The Folders portlet is displayed on the left. The ESM-8027 
Trade Liquidation ADCVD Entry Summary report is displayed in the 
portlet on the right. 
 
 The AD-8027 Aged Liquidation AD/CVD Entry Summary report is also 
new to this release.  To view details about this report select the 
Authorized Data Extract folder. 
 
Highlight Box: The Authorized Data Extract folder is highlighted. 
 
Click Box: Select the Authorized Data Extract folder to continue. 
 

Screen 20: 
 
New Reports 
Image: The Authorized Data Extract portlet displays on the right and 
list the various reports that are available. 
 
 In order to view the report listing for the AD-8027 Aged Liquidation 
ADCVD Entry Summary Report, scroll down in the Authorized Data 
Extract portlet and then select the report name. 
 
Highlight Box: The AD-8027 Aged Trade Liquidation ADCVD Entry 
Summary Report listing is highlighted. 
 
Click Box: Select the AD-8027 Aged Trade Liquidation ADCVD Entry 
Summary Report listing to continue. 
 

Screen 21: 
 
New Reports 
Image: The Folders portlet displays on the right. The Schedule portlet 
displays for the AD-8027 Trade Aged Liquidation ADCVD Entry 
Summary Report. The Prompts section lets you modify dates for the 
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report. A Schedule and a Cancel button are located in the lower right 
corner of this screen. 
 
 ACE displays the AD-8027 Trade Aged Liquidation ADCVD Entry 
Summary Report in the Schedule portlet. Because of the size of this 
data extract report, you must schedule this report to run. To do this, 
you would select the Schedule button located in the lower right-hand 
side of the screen. 
 

Screen 22: 
 
New Reports 
 
Image: The Folders portlet displays on the right. The Schedule portlet 
displays for the AD-8027 Trade Aged Liquidation ADCVD Entry 
Summary Report. The Prompts section lets you modify dates for the 
report. A Schedule and a Cancel button are located in the lower right 
corner of this screen. 
 
 If you need assistance with any of the terms in the ACE Reports 
functionality, you can go to the Help folder. Select the Help folder now. 
 
Highlight Box: The Help folder is highlighted. 
 
Click Box: Select the Help folder to continue. 
 

Screen 23: 
 
New Reports 
Image: The Folders portlet displays on the left. The Help portlet 
displays on the left with a listing of help options listed in the space 
below. 
 
ACE displays the Help menu options. There are several options 
available, one is the Reports dictionary that contains details on all data 
elements in ACE reports, based on user role. 
 
Highlight Box: The ACE Report Dictionary – Importers Properties is 
highlighted. 
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Click Box: Select the Reports Dictionary- Importers Properties to 
continue. 
 

Screen 24: 
 
New Reports 
 
Image: The Folders portlet displays on the left. The ACE Portal Reports 
Dictionary: Importers displays on the right. 
 
Select the Help folder. 
 
Highlight Box: The Help folder is highlighted. 
 
Click Box: Select the Help folder  to continue. 
 

Screen 25: 
 
New Reports 
Image: The Folders portlet displays on the left. The Help portlet 
displays on the left with a listing of help options listed in the space 
below. 
 
 You are back at the Help portlet.  Another help option is the Trade 
Reports User Guide 6-30-09. 
 
Highlight Box: The Trade Reports User Guide 6-30-09 is highlighted. 
 
Click Box: Select the Trade Reports User Guide 6-30-09 to continue. 
 Select the Trade Reports User Guide 6-30-09. 
 

Screen 26: 
 
New Reports 
Image: The Folders portlet displays on the left. The Trade Reports 
User Guide 06-30-09 displays on the right. 
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ACE displays the Trade Reports User Guide 06-30-09. You can print 
the user guide or use the online version. 
 
Click Box: Select the Forward to continue. 
 

Screen 27: 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
In order to run ESM-8027 or AD-8027, you must enter which one of 
the following dates in the report parameters? 
A) Date Valid (from) and (to) 
 
B) Suspend ES Effective Date Range (begin) and (end) 
 
C) Notice Date (begin) and (end) 
 
D) Due Date (begin) and (end) 
 
 The correct answer is B.  

 
Image:  Pencil filling in an answer on a standardized test. 
 

Screen 28: 
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
Which of the following reports are new for this release? 
 
A) ESM-7068 Entry Summary report 
B)  ESM-7008 Entry Summary Line Detail report 
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C) ESM-8027 Trade Aged Liquidation AD/CVD report and the AD-8027 
Trade Aged Liquidation AD/CVD report 
D) Trade Declaration report-AM 7002 
 
 The correct answer is C.  

 
Image:  Pencil filling in an answer on a standardized test. 
 
Screen 29: 
 
Summary 
 
 Summary 
 
Congratulations!  You have completed Topic 1: New AD/CVD Entry 
Summary Reports.  You now have the knowledge necessary to: 
 
Locate and run ESM-8027 Aged Liquidation AD/CVD Entry Summary 
Report. 
 
Locate and schedule AD-8027 Aged Liquidation AD/CVD Entry 
Summary Extract Report. 
 
Locate the ACE Portal Reports Dictionary and the Trade Reports User 
Guide. 
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Topic 2: ACE Report Enhancement 
 
Screen 1: 
 
 AD/CVD Reports  - ACE Report Enhancement 
 
Image: ACE logo with text – Providing the right information to the 
right people at the right time. 
 
Screen 2:   
 
 Objectives 
 
Upon completion of this topic, ACE Report Enhancement, you will be 
able to: 
 
Identify enhancements to the following reports: ESM-7068 Entry 
Summary, ESM-7008 Entry Summary Line Detail and ESM-7025 CBP 
28, 29, 4647 Status Report. 
Recognize modifications to AM-7002 Trade Declaration Report. 
            
Screen 3: 
   
Enhanced ACE Report  
 
 The following reports have been enhanced for AD/CVD information: 
  Entry Summary (ESM 7068) 
  Entry Summary Line Detail (ESM 7008) 
  CBP Form 28, 29, 4647 Status (ESM 7025) 
The AM-7002 Trade Declaration Report has been modified to capture 
the declaration information that brokers enter for Non-Portal accounts. 
  
  
Image: CBP officer directing traffic at a port. 
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Screen 4: 
 
Information on How to Use the ACE Report Functionality 
 
 If you are unfamiliar with how to run ACE reports, it is recommended 
that you visit: http://nemo.cbp.gov/ace_online and complete the web-
based training, ACE Reports for the Trade Community. 
 
Note: To access this course, use the following information: 
User Name: user01 
Password: 1Password  
 
Image: Screen capture of the ACE Online Web Based Training Menu 
with a listing of options. 

 
Screen 5: 
 
New Reports 
 
Image: ACE Portal Homepage is displayed.  
 
 Once you have Logged into the ACE Portal homepage, select the 
Accounts tab. 
 
Highlight Box: The Accounts tab is highlighted. 
 
Clickbox: Select the Accounts tab to continue. 
 

Screen 6: 
 
New Reports 
 
Image: The Accounts tab is displayed with the Task Selector portlet on 
the left. The Task Selector portlet contains two sections, the Select 
Account Type and Select Task. The Account Selector List portlet is 
displayed below the Task Selector portlet on the left. The Account 
Selector List Portlet contains two sections, View Setting and Accounts.  
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The View Top Account Portlet displays on the right and displays the 
broker information. The Broker portlet is displayed below the View Top 
Account portlet and is currently blank. 
 
 Importers with an ACE Portal Account must select Importer from the 
View drop-down arrow list and then select GO. 
 
Brokers with an ACE Portal account must accept the Broker default in 
the View drop-down arrow list. 
 
For this practice, you will leave the View drop-down arrow list at 
Broker. To continue, select the Reports link in the Task Selector 
portlet. 
 
Highlight Box: The Reports hyperlink in the Select Task section is 
highlighted. 
 
Click Box: Select the Reports hyperlink in the Task Selector section to 
continue. 
 
Select Reports from the Task Selector portlet. 
             

Screen 7: 
 
New Reports 
 
Image: The Accounts tab is displayed with the Task Selector portlet on 
the left. The Task Selector portlet contains two sections, the Select 
Account Type and Select Task. The Account Selector List portlet is 
displayed below the Task Selector portlet on the left. The Account 
Selector List Portlet contains two sections, View Setting and Accounts.  
The Broker Summary Portlet displays on the right and contains the 
Broker name and ACE ID number. Below the Broker Summary is the 
Launch Reports and Quickview Tool portlet. This portlet contains the 
Launch Tool button.  
 
 Select Launch Tool 
 
Highlight Box: The Launch Tool button is highlighted 
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Clickbox: Select the Launch Tool button to continue. 
 

Screen 8: 
 
Launch Tool 
 
Image: The Welcome to ACE Reports screen displays 
 
 ACE will launch the ACE Secure Data Portal in a separate window. 
             

Screen 9: 
 
New Reports 
Image: The Welcome to ACE Reports displays with the Folders portlet 
displayed on the left. Located below the Folders portlet is the Home 
icon and below the Home icon are the My Folders and Public Folders 
icons.  

 
 To display a listing of available folders from the Public Folders, select 
the + icon. 
 
Highlight Box: The + icon next to the Public Folders is highlighted. 
 
Click Box: Select the + icon next to Public Folders to continue. 

 
Screen 10: 
 
New Reports 
Image: The Public Folders icon has been expanded and now displays a 
listing of folders. 
 
 To review these modifications, select the Entry Summary folder. 
 
Highlight Box: The Entry Summary folder located within the Public 
Folders is highlighted. 
 
Clickbox: Select the Entry Summary folder to continue. 
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Screen 11: 
 
New Reports 
Image: The Entry Summary folder has been selected and displays a 
listing of entry summary reports in the Entry Summary portlet on the 
right. 
 
 ACE displays a listing of reports in the Entry Summary portlet. 
 
The ESM-7068 Entry Summary report provides an overview of 
antidumping and countervailing duties (AD/CVD) that can be used to 
support a broker’s internal audits or those of their importer clients. 
 
 
Highlight Box: The Modify hyperlink located beneath the report listing 
for ESM-7068 Entry Summary Report in the Entry Summary portlet is 
highlighted. 
 
Click Box: Select the Modify hyperlink to continue. 
 

Screen 12: 
 
New Reports 
 
Image: The Folders portlet is located on the left and Entry Summary 
folder has been selected. The ESM-7068 Entry Summary Report portlet 
is displayed on the left. The Prompts box is located within the ESM-
7068 Entry Summary Report portlet.   
 
 The Prompts dialogue box displays. There are two dates that must be 
typed before you can run the ESM-7068 Entry Summary Report in the 
Edit Query mode. ACE displays red arrows (     )next to each text box 
that must be completed. These required data entry text boxes include 
begin and end dates and include the Release Date and the Entry Date.     
Click Box:  
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Screen 13: 
 
New Reports 
 
Image: The data entry dates have been completed in the Prompts box 
and there are green circles with white check marks next to each date 
that has been typed.  
 
 As each text entry box is filled, ACE will display a green circle with a 
white check.  Once all the required text boxes have been completed, 
ACE enables the Run Query button.      

 
Highlight Box: The Edit Query button is highlighted. 
 
Click Box: Select the Edit Query button to continue. 
 

Screen 14: 
 
New Reports 
 
Image: The Edit Query button in the menu bar for the ESM-7068 Entry 
Summary Report portlet has been activated. 
 
 ACE displays the ESM-7068 Entry Summary Report.  Select the Edit 
Query button. 
 
Highlight Box: The Edit Query button is highlighted. 
 
Click Box: Select the Edit Query button to continue. 
 

Screen 15: 
 
New Reports 
 
Image: The Edit Query mode is displayed. The Data panel is on the left 
and the selected elements or objects are displayed on the right.  
 
 You are now in the Edit Query mode of ACE Reports, ESM-7068 Entry 
Summary. The Data panel contains parameters you will need to run a 
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report with AD/CVD information. The blue squares are for qualitative 
parameter (names), the pink squares are for quantitative parameter 
(numbers) and yellow funnels are filters. 
 
Click and drag any of these AD/CVD qualitative or quantitative objects 
to the Results Objects panel in order to add these elements to your 
reports headers.      
 
Rollover Text Caption located on the Data panel: The qualitative 
objects that have been added include Company Case Information, 
Related Company Case Number, Company Number, Official Case 
Name, Continuous Superseded Bond Indicator, Additional Bond Type 
Code, Additional Surety Code, Additional Single Entry Bond Producer 
Account Number, ADD Non-Reimbursement Statement Indicator, and 
CVD Non-Reimbursement Statement Indicator. 
 
The quantitative elements include: Additional Single Entry Bond 
Amount, Total Bonded ADD Amount, Total Cash Deposit ADD Amount, 
Total bonded CVD Amount, and Total Cash Deposit CVD Amount 
 
 
Highlight Box: The Data panel is highlighted. 
 Rollover the Data panel to see a list of new data object for this 
release.   
 
 

Screen 16: 
 
New Reports 
 
Image: The Folders portlet is displayed on the left. The Edit Query 
mode is displayed on the right.  
 
 To review the modifications to 7008 Entry Summary Line Detail 
Report, select the Entry Summary folder from the Folders portlet. 
 
Highlight Box: The Entry Summary folder located in the Public Folders 
is highlighted. 
 
Click Box: Select the Entry Summary folder to continue. 
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Screen 17: 
 
New Reports 
 
Image: The Entry Summary portlet is displayed. A listing of available 
entry summary reports is displayed.  
 
 You are returned to the Entry Summary portlet. 
 
The ESM-7008 Entry Summary Line Detail Report can be used to 
research entry summaries and to detect systemic problems related to 
the use of special trade programs. 
 
Highlight Box: The Modify hyperlink located beneath the ESM-7008 
Entry Summary Line Detail Report is highlighted. 
 
Click Box: Select the Modify hyperlink to continue. 
 
Select the Modify hyperlink located beneath the ESM-7008 Entry 
Summary Line Detail Report. 
 

Screen 18: 
 
New Reports 
 
Image: The Folders portlet is displayed on the left. ESM-7008 Entry 
Summary Line Detail Report portlet is displayed on the right. 
 
 The Prompts dialogue box displays. The Entry Date must be typed 
before you can run the ESM-7008 Entry Summary Line Detail Report in 
the Edit Query mode.  
 
The new qualitative and quantitative data objects that you reviewed 
for the ESM-7068 Entry Summary Report are also available here for 
the ESM-7008 Entry Summary Line Detail Report. 
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Highlight Box: The Entry Date (begin) and Entry Date (End) listings is 
highlighted. 
 

Screen 19: 
 
New Reports 
 
Image: The Prompts box displays the Entry Date (begin) and Entry 
Date (end) listings with a green circle with a white check mark to the 
left of each of these items.  
 
 Once the required field are completed, ACE enables the Run Query 
button.  Select the Run Query button to continue. 
 
Highlight Box: The Edit Query button is highlighted. 
 
Click Box: Select the Edit Query button to continue. 
 

Screen 20: 
 
New Reports 
 
Image: The Folders portlet is displayed on the left. The ESM-7008 
Entry Summary Line Detail Report portlet is displayed on the left.  
 
 After reviewing the ESM-7008 Entry Summary Line Detail Report, 
select the + icon adjacent to the Account Management folder.    
 
Highlight Box: The + icon next to the Account Management folder is 
highlighted. 
 
Click Box: Select the + icon next to the Account Management folder to 
continue. 
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Screen 21: 
 
New Reports 
 
Image: The Account Management folder is expanded and displays the 
account management folders. 
 
 ACE displays the Account Management folders. Select the Declarations 
folder to continue.  
 
Highlight Box: The Declarations folder located from the Account 
Management folder is highlighted. 
 
Click Box: Select the Declarations folder to continue. 
 

Screen 22: 
 
New Reports 
 
Image: The Folders portlet is displayed on the left. The AM-7002 Trade 
Declarations Report listing is displayed in the Declarations portlet on 
the right. 
 
 ACE displays the AM-7002 Trade Declarations Report in the 
Declarations portlet. 
 
Highlight Box: The Modify hyperlink located beneath the AM-7002 
Trade Declarations Report listing is highlighted. 
 
Click Box: Select the Modify hyperlink to continue. 
 
 Select the Modify hyperlink for AM-7002 Trade Declarations Report.  
 

Screen 23: 
 
New Reports 
 
Image: The Folders portlet is displayed on the left. The Prompts box 
displays in the AM-7002 Trade Declaration portlet. The Date Valid 
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From and Date Valid To items display a red arrow to the left of each 
item. 
 
 ACE displays the Prompts Dialog box. There are two dates that must 
be typed before you can run the AM-7002 Declarations Report in the 
Edit Query mode, the Date Valid From and Date Valid To dates. 
 
Highlight Box: The Date Valid From and Date Valid To items in the 
Prompts box are highlighted. 
 
Click Box:  
 

Screen 24: 
 
New Reports 
 
Image: The Folders portlet is displayed on the left. The Prompts box 
displays in the AM-7002 Trade Declaration portlet. The Date Valid 
From and Date Valid To items display a green circle with a white check 
mark in the middle to the left of each item. 
 
 Once the required field are completed, ACE enables the Run Query 
button.  Select the Run Query button to continue. 
 
Highlight Box: The Run Query button in the Prompts box is 
highlighted. 
 
Click Box: Select the Run Query button to continue. 

 
Screen 25: 
 
New Reports 
 
Image: The Folders portlet is displayed on the left. The AM-7002 Trade 
Declarations report is displayed in the Edit Query mode on the right. 
 
 ACE displays the AM-7002 Trade Declarations Report. 
 
Click Box:  
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Screen 26: 
 
New Reports 
 
Image: The AM-7002 Trade Declarations Report is displayed. 
 
 Within the AM-7002 Trade Declarations Report, there are four new 
columns.  Rollover the highlighted columns. 
 
Highlight Box: The Created for Account Name column is highlighted. 
Rollover  For importers with or without an ACE Portal account, ACE 
displays the importer name. 
 
Highlight Box: Created for Account Identifer column is highlighted. 
Rollover For importers with or without an ACE Portal account, ACE 
displays the IR#, SSN, or CBP assigned number. 
 
Highlight Box: Created by Account Name column is highlighted. 
Rollover  For importers without an ACE Portal account, ACE displays 
the name of the broker with the ACE Portal account. 
 
Highlight Box: Created by Account Identifier column is highlighted. 
Rollover  For importers with an ACE Portal account, ACE displays the 
IR #, SSN, or CBP assigned number.  
For importers without an ACE Portal account, ACE displays the filer 
code of the broker with an ACE Portal account. 
             

Screen 27: 
 
New Reports 
 
Highlight Box: The … is highlighted. 
 
Click Box: Select the … to continue. 
 
 
               
               



Web-based Training Guide for   Lesson 5 
Forms, Declarations, & AD/CVD Cases Web-based Training  
 

138 

Screen 28: 
 
New Reports 
 
Highlight Box: The … is highlighted. 
 
Click Box: Select the … to continue. 
 

Screen 29: 
 
Knowledge Check Question 1 
 
 Knowledge Check 
 
Choose the best answer from the list below and then select the Check 
Answer button. 
Which one of the following reports has been enhanced with new data 
elements for AD/CVD reports? 
 
A) Entry Summary ESM-7008 
B)  Trade Declarations report AM-7002 
C) ESM-7001 Summary Census 
D) ESM-7024 ACE Reject report 
 
 The correct answer is A.  

 
Image:  Pencil filling in an answer on a standardized test. 
 
 Screen 29: 
 
Summary 
 
 Summary 
 
Congratulations!  You have completed Topic 2: ACE Reports 
Enhancements. You now have the knowledge necessary to: 
 
Identify enhancements to the following reports: ESM-7068 Entry 
Summary and ESM-7008 Entry Summary Line Detail and ESM-7025 
CBP 28, 29, 4647 Status Report. 
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Recognize modifications to AM-7002 Trade Declaration Report. 
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